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Sales 
The sales system in Synergetic allows you to manage all aspects of sales of stock items and services. 

This includes: 

 maintaining information about stock items 

 managing the sales invoicing procedures. 

You can: 

 Maintain items. See Maintaining items (on page 5). 

 Enter sales. See Entering sales (on page 53). 

 Close off sales periodically. See Closing off sales (on page 107). 

 Manage stock items, including consignment stock. See Managing stock (on page 133). 

 View details about stock, including information about stock movement. See Stock Summary 
window (on page 136). 

 Run reports. See Key sales reports (on page 223). 
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What's new to Sales 

Version 65 

This section outlines changes to the Sales manual arising from changes made to Synergetic (versions 
64.13-65.19). 

Note: The look and feel of Synergetic depends on the PC it is running on. The screenshots in this 
manual use both the version 65 and pre-65 look and feel. You may notice a slight difference in 
appearance between this manual and Synergetic running at your organisation but the functionality 
is exactly the same. 

 

Change More information See... 

New notification for 
price changes when 
a new customer is 
selected. 

If you choose a new customer that belongs to a different 
price group, a warning label is displayed in the Sales 
Entry window. 

Using the Sales 
Entry window (on 
page 63) 

New grid fields in the 
Purchase Order 
and Receipts tabs 
of the Item 
Maintenance 
window. 

The Delivery Date and Delivery Docket No fields are 
now available on the Purchase Order tab. 

The Invoice Number and Delivery Docket No fields 
are now available on the Receipts tab. 

 

Item Maintenance - 
Purchase Orders 
tab (on page 38) 

Item Maintenance - 
Receipts tab (on 
page 27) 

New button in Stock 
tab of Item 
Maintenance 
window. 

You can print barcodes immediately from the Stock tab 
of the Item Maintenance window. 

 

Item Maintenance - 
Stock tab (on page 
19) 

Regular sale 
replaces Normal 
sale. 

To prevent confusion with an item's Normal price, 
Normal sales are referred to as Regular sales. 

 

Multiple date formats 
supported. 

Synergetic supports dates being entered in formats that 
do not match the regional settings. 
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Change More information See... 

Print Barcodes 
available from Item 
Maintenance 
selector. 

You can print the item barcode queue from the Item 
Maintenance selector window. 

 

Synergetic Financial 
Configuration - 
Business Units - 
Sales sub-tab - 
Page 4 sub-tab in 
the Finance manual. 

New staff barcode 
for sales entry. 

If your organisation does not use the Advanced Point 
Of Sale, you can scan a barcode to select a staff 
member in the Staff Search window. 

 

Using the New Sale 
window (on page 
55) 

Finance 
Configuration 
Maintenance - 
Business Units - 
Sales sub-tab in the 
Finance manual. 
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Maintaining items 
Use the Item Maintenance function in Synergetic to view and maintain all the information about items 
that your organisation stocks and sells. 

Some items are not stocked. For example, service items that you supply. 

Stocked items at your organisation comprise: 

 An item record that you maintain key information about, including units of measure. 

 A stock record that is used by one or more of your business units to manage and sell stock 
items. See Entering sales (on page 53) and Managing stock (on page 133). 

Business units 

Business units are set up at your organisation to manage and sell stock items. For example, a 
bookshop and a uniform shop can operate independently. 

Smaller organisations can choose to set up one business unit only. 

Also, see the Business Units tab of Maintaining finance configuration files in the System maintenance 
manual. 

How to: 

 Search for an item on the system. See Searching for items (on page 7). 

 Create a new item. See Creating new items (on page 10). 

 Create a stock item record for a new business unit, if it already exists for another business 
unit. See Creating stock items for business units (on page 24). 

What you can do: 

What you can do… See… 

Maintain: 

 key item details 

 unit of measure settings. 

Item Maintenance - Item tab (on page 16) 

Maintain details about an item's suppliers. Item Maintenance - Suppliers tab (on page 25)

You can: 

 maintain stock detail for business units that 
stock and sell items 

 receive stock purchased from a supplier or 
acquired as consignment stock 

 add or delete a stock record at a business 
unit 

 mark a stock as active or inactive at a 
business unit 

 manually adjust average costs. 

Item Maintenance - Stock tab (on page 19) 
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What you can do… See… 

You can: 

 view summary information about stock 
receipts 

 receive stock either: 

– purchased from a supplier 

– acquired as consignment stock. 

 maintain stock receipts 

 view stocktake adjustments. 

Item Maintenance - Receipts tab (on page 27) 

Summarise stock held at your organisation for the 
selected item, by business unit. 

Item Maintenance - Stock at Business Units 
tab (on page 31) 

View details of consignment stock payments. Item Maintenance - Payment tab (on page 33)

View sales of stock items by business unit. Item Maintenance - Sales tab (on page 35) 

View purchase orders for stock items by business 
unit. 

Item Maintenance - Purchase Orders tab (on 
page 38) 

Define your own tabs or programs within Synergetic. Item Maintenance - User Forms tab (on page 
40) 

Maintain documents relating to the item. Item Maintenance - DocMan tab (on page 42) 

View information about stock movement: 

 for different business units 

 by month 

 by order, receipt or sales transaction. 

Item Maintenance - Stock Movement tab (on 
page 46) 
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Searching for items 
Use the Set Item Search Criteria window to search for items. 

See Searching in the Introduction manual for information on how to use the search tools. 

Note: If the item is not found, click  to add a new item from this window. See Creating 
new items (on page 10). 

Opening the Set Item Search Criteria window 

To open the Set Item Search Criteria window: 

1. Select Module > Sales > Item Maintenance from the main menu. 

The Set Item Search Criteria window is displayed. 

 

2. Type in the information you know about the item or group of items. 

3. Click . 
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Set Item Search Criteria key fields 

Item area fields 

Field Description 

Business Unit Select the business unit the stock items are set up for. 

Item Lookup Defaults to the item description.  

Note: You can enter part or all of the item lookup. 

You can change this in Item Maintenance to assist you with searching and 
sorting if required. 

Description Type part or all of the description of the stock item. 

Item Code Type all or part of the item code. 

You can search for items using wildcards. See Using wildcards to search in 
the Introduction manual. For example, you can search for items, with item 
codes such as 001001A, using the 00% wildcard. 

 

Category Select a category for a group of items. 

Bar Code Type the barcode attached to an item. 

You can search for items using wildcards. See Using wildcards to search in 
the Introduction manual. For example, you can search for items, with 
barcodes such as 001016, using the %10% wildcard. 

 

Size Type the size of the stock item. For example, uniform items of a certain size.
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Field Description 

In Stock Items This can be either: 

 Yes - limit search to items with more than zero stock on hand 

 No - limit search to items with zero or negative stock on hand 

 Blank - ignore stock on hand. 

Consignment stock Search for consignment stock items or exclude consignment stock items.  

This can be either: 

 Yes - limit search to consignment stock 

 No - limit search to stock that is not consignment stock 

 Blank - ignore consignment status.  

The supplier owns consignment stock until you sell it on their behalf. 

For example, second-hand uniforms and books can be on consignment. 
When you sell the items, you remit money to the person selling the items, 
less a commission for handling. 

Active Stock Select to filter by: 

 Yes - active items only 

 No - inactive items only 

 blank - ignore item's active status. 

Creditor area fields 

Field Description 

Name Type in all or part of the creditor's or payee’s name. 

ID Type in the Synergetic ID of the creditor, including consignors. 
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Creating new items 
To create a new item, you can: 

 click  on the Set Item Search Criteria window 

 click  on the Item Maintenance toolbar 

 select File > New... from the main menu 

 right click on the Item Selector grid and select New... 

 press Ctrl + N. 

The Create New Item windows follow: 

 Create New Item - Create Item window. (on page 11) 

 Create New Item - Business Units window (on page 13). 

You can navigate between the windows by clicking  and  as required. 

Note: Once a new item record is added, you can maintain other information about the item in Item 
Maintenance. See Maintaining items (on page 5). 
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Create New Item - Create Item window 

Use the Create New Item - Create Item window to enter key details for an item. 

1. Open the Create New Item window. See Creating new items (on page 10). 

The Create New Item - Create Item window is displayed. 

 

2. Enter the information you know about the item. 

3. Click . 

The Create New Item - Business Units window is displayed. See Create New Item - Business 
Units window (on page 13). 
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Create New Item - Create Item window key fields 

Field Description 

Item Code Unique code for the item. 

Note: You can allow Synergetic to automatically generate item codes 
when you are creating new items, or you can develop your own naming 
convention. Synergetic uses a six digit zero-filled number for the auto 
number, based on the Last Item Sequence number in the Items 
Invoicing tab of Finance Configuration Maintenance. For example, 
001025. See Synergetic Financial Configuration - Items/Invoicing tab in 
the Finance manual. 

Description Description for the item. 

Note: This field is mandatory. 

Item Lookup Determines the order that items are listed in the search grid, and can be 
used to search for items. 

Defaults to the value of the Description field but can be changed. For 
example, you may want to list items in a size order, by putting the size at the 
start of the lookup. 

Note: This field is mandatory. 

Category Group used to categorise this item. 

For example, Uniform or Books can be set up as categories to group 
similar items together. 

Barcode Used for barcoding applications involving stock items. 

If left blank, this defaults to the item code. 

For example, books that are stocked and sold at your organisation can be 
integrated with POS (point of sale) equipment, using barcodes to speed up 
the sales entry process. 

Size Size of the stock item, if required. 

For example, items of uniform are available in different sizes. 

Consignment Item Select if the item is a consignment stock item. 

The supplier owns consignment stock until you sell it on their behalf. 

For example, second-hand uniforms and books can be on consignment. 
When you sell the items, you remit money to the person selling the items, 
less a commission for handling. 

Note: If Consignment Item is selected, the Stock at Business Units 
tab is replaced by the Payments tab, and you can only receive one unit 
of stock which must be at no cost. See Item Maintenance - Payment tab 
(on page 33). 

Stocked Item Clear if the item is not a stocked item. 

For example, your organisation may provide services or goods that you 
order in on behalf of students, such as musical instruments. 

Note: Items that are not stocked can be sold, but do not have Stock On 
Hand tracked. 
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Create New Item - Business Units window 

Use the Create New Item - Business Units window to: 

 select the business units that use the item 

 enter details for an item that are specific to a business unit. 

Note: When creating an item, all business units have the same details. This information can later 
be maintained separately for each business unit. 
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Create New Item - Business Units window key fields and buttons 

Fields 

Field Description 

Business Units Select one or more business units that stock the item being created. 

For example, when setting up a uniform stock item, you would set this up in 
the uniform department but not the bookshop department. 

Unit Price Price that each unit is sold for. 

Note: This field can be inclusive or exclusive of tax, depending on your 
Financial Configuration Maintenance settings. See Synergetic 
Financial Configuration - Business Units tab in the Finance manual. 

Create Receipt 
Record 

Select to create a receipt for a quantity of one. 

Note: This field only appears if the item has been flagged as 
Consignment Stock in the Create New Item window. 

Override G/L Code When a sale is made, by default it is posted to a specified G/L control 
account. If you want to use a different G/L account for this item, select a 
different one here. 

Tax Code Tax code used for the item, which is used for tax reporting on sales. 

Re-Order Quantity Reference figure used to nominate the amount of stock reordered, when the 
stock level falls below the Re-Order Stock Level value. 

The quantity that you reorder is similar to the economic order quantity, the 
most economical amount to purchase from the supplier. For example, if you 
have the funds and the storage capacity, you might order uniforms in 
quantities of 100 as the supplier may have a cheaper wholesale unit price. 

Re-Order Stock 
Level 

Reference figure used to nominate the stock level below which you need to 
reorder more stock. 

Reorder information is used by the Re-order report. 

Normal Creditor ID Synergetic identifier for the: 

 supplier that you normally order this stock item from 

 owner of the stock if this is a consignment item. 

You can: 

 type the value directly into the field  

 populate this field using the  button  

 clear the field using the  button. 
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Buttons 

Button Description 

 
Select the supplier using the Creditor Search window. 

 

 
Clear the value from the Normal Creditor ID field. 

You can also clear the Normal Creditor ID field directly. 
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Item Maintenance - Item tab 
Use the Item tab to maintain: 

 key item details 

 unit of measure settings. 

Opening the Item tab 

To open the Item tab: 

1. Select Module > Sales > Item Maintenance from the main menu. 

The Set Item Search Criteria window is displayed. 

Tip: You can also access the Sales functions by clicking . 

2. Select the item. See Searching for items (on page 7). 

The Item tab of the Item Maintenance window is displayed. 
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Item Maintenance - Item tab key fields 

Item Details area fields 

Field Description 

Description Description for the item. 

Note: This field is mandatory. 

Item Lookup Determines the order that items are listed in the search grid, and can be 
used to search for items. 

Defaults to the value of the Description field but can be changed. For 
example, you may want to list items in a size order, by putting the size at the 
start of the lookup. 

Note: This field is mandatory. 

Category Group used to categorise this item. 

For example, Uniform or Books can be set up as categories to group 
similar items together. 

Barcode Used for barcoding applications involving stock items. 

If left blank, this defaults to the item code. 

For example, books that are stocked and sold at your organisation can be 
integrated with POS (point of sale) equipment, using barcodes to speed up 
the sales entry process. 

Size Size of the stock item, if required. 

For example, items of uniform are available in different sizes. 

Consignment Item Select if the item is a consignment stock item. 

The supplier owns consignment stock until you sell it on their behalf. 

For example, second-hand uniforms and books can be on consignment. 
When you sell the items, you remit money to the person selling the items, 
less a commission for handling. 

Note: If Consignment Item is selected, the Stock at Business Units 
tab is replaced by the Payments tab, and you can only receive one unit 
of stock which must be at no cost. See Item Maintenance - Payment tab 
(on page 33). 

Stocked Item Clear if the item is not a stocked item. 

For example, your organisation may provide services or goods that you 
order in on behalf of students, such as musical instruments. 

Note: Items that are not stocked can be sold, but do not have Stock On 
Hand tracked. 
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Field Description 

Enforce Manual 
Description when 
Sold 

Select if you need a description to be entered when the item is sold. 

For example, you can use this for service items. The service item might have 
Time Onsite as its default description. However, you want a specific 
description of what has actually been done. To do this, you select this field to 
force the user to enter the description of the task performed. 

Allow Label to be 
Printed 

Allows you to print a barcode label for items that do not have a barcode yet. 

This is used by the label report. 

Units of Measurement area fields 

Field Description 

When Sold Unit of measure of the stock item when sold. 

For example, unit of measure can be EA (each). 

When Supplied Unit of measure of the stock item when purchased or received on 
consignment. 

For example, unit of measure may be BX10 (Box of 10). A uniform item may 
be purchased in boxes of 10 then sold as EA (each). 

Units Supplied to 
Stock 

Number of units that were delivered into stock. For example, receiving one 
box of pencils supplies 25 units (individual pencils) to stock. 

Note: If this field is a value other than one, stock receipts and purchase 
orders are multiples of this field. For example, if you order 5 boxes of 
pencils, the purchase order lists 125 individual pencils. 
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Item Maintenance - Stock tab 
Use the Stock tab to: 

 maintain stock detail for business units that stock and sell items 

 receive stock purchased from a supplier or acquired as consignment stock 

 add or delete a stock record at a business unit 

 mark a stock as active or inactive at a business unit 

 manually adjust average costs. 

Stock is stored separately for each business unit. 

Opening the Stock tab 

To open the Stock tab: 

1. Select Module > Sales > Item Maintenance from the main menu. 

The Set Item Search Criteria window is displayed. 

Tip: You can also access the Sales functions by clicking . 

2. Select the item. See Searching for items (on page 7). 

The Item tab of the Item Maintenance window is displayed. 

3. Click the Stock tab. 

The Stock tab of the Item Maintenance window is displayed. 

 

4. Select the business unit you are maintaining stock details for. 
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Note: You only need to select the business unit if stock is maintained in separate departments 
and you are authorised to work with multiple business units. 

Item Maintenance - Stock tab key fields and buttons 

Fields 

Field Description 

Business Unit Select the business unit at your organisation, to maintain the stock details for 
the item for the selected business unit. 

If there is no stock record for the selected business unit, the following 
message is displayed: 

 

Click  to create stock for this item at the 
business unit. See Creating stock items for business units (on page 24). 

Active Stock Select to indicate that the item is a current stock item.  

To clear the field, click . Inactive items are not displayed on the 
Stock Item Search window and are no longer available for sale. 

Stock On Hand Quantity of stock on hand at the business unit. 

Average Cost (Ex 
Tax) 

Average purchase cost of the item, (excluding tax) used to determine the 
profit made on each item and create cost of sale journals. 

This is calculated by Synergetic using a weighted average cost. Specifically, 
each time you purchase stock the average cost is adjusted based on the: 

 weighted difference between the average cost of items already in 
stock 

 unit cost of the items being purchased. 
 

Note: You can override the value in this field by clicking . 
This creates an adjustment receipt for zero units to record the change. 

Override Sale G/L 
Code 

When a sale is made, by default it is posted to a specified G/L control 
account. If you want to use a different G/L account for this item, select a 
different one using this field. 

Tax Code Tax code used for the item, which is used for tax reporting on sales. 

Re-Order Quantity Reference figure used to nominate the amount of stock reordered, when the 
stock level falls below the Re-Order Stock Level value. 

The quantity that you reorder is similar to the economic order quantity, the 
most economical amount to purchase from the supplier. For example, you 
may order uniforms in quantities of 100 as the supplier may have a cheaper 
wholesale unit price, if you have the funds and the storage capacity. 

Re-Order Stock 
Level 

Reference figure used to nominate the stock level below which you need to 
reorder more stock. This is used for re-order reports. 
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Grid area fields 

Field Description 

Price Group No. Number for the price group. 

 Desc Description for the price group. 

 GL Selected if the price group is for internal general ledger 
sales only. 

 Tax Code Tax code for the price group. 

 Method Pricing or profit method for the price group. 

Threshold Min Unit Price Minimum unit price for the item. This field is highlighted if 
the actual unit price is below this amount. 

 Profit Minimum profit for the item. This field is highlighted if the 
actual profit is below this amount. 

Threshold Max Unit Price Maximum unit price for the item. This field is highlighted if 
the actual unit price is above this amount. 

 Profit Maximum profit for the item. This field is highlighted if the 
actual profit is above this amount. 

Policy Description Whether the discount policy for the price group uses: 

 Default - the default price group pricing 

 Cost - the average cost of the item 

 Manual - a manual price set in Item Maintenance.

See Synergetic Financial Configuration - Business Units - 
Price Groups sub-tab in the Finance manual. 

 Discount Discount applied for this price group. 

Note: Negative values create a surcharge. For 
example, -10 applies a 10% surcharge,  

Editable Apply Select to apply this price group policy for this item. 

 Unit Price Price to charge the student or debtor for each item sold. 
This field is editable. 

Note: This can be inclusive or exclusive of tax, 
depending on the finance configuration settings for the 
price group. See Synergetic Financial Configuration - 
Business Units tab in the Finance manual. 

Actual Ex Tax Price excluding tax. 

 Inc Tax Price including tax. 

 Profit Actual profit for the item. 
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Buttons 

Button Description 

 
Receive stock into a business unit. See Manually receipting stock (on page 
134). 

 
Unprotect the Average Cost field, so that you can type in a new value. 

Note: Also see the  button, as the buttons toggle depending 
on whether the field is protected or not. 

 
Protect the Average Cost field after adjusting their values.  

Note: Also see the  button, as the buttons toggle depending 
on whether the field is protected or not. 

 
Depending on the location of the button, launch into either: 

 General Ledger Maintenance. See Maintaining general ledger 
accounts in the General ledger manual.  

 Creditor Maintenance. See Maintaining creditors in the Creditors 
manual. 

Launch the Stock Summary window to create a purchase order for this 
item. See Stock Summary - Suppliers for Stock tab (on page 139). 

Launch the Print Labels window to print barcode labels immediately. 

 

Add labels for this item to the label print queue. The number of labels to print 
defaults to the Stock On Hand.  

Note: You can print the label queue in the Page 4 sub-tab of the Sales 
sub-tab of the Business Units tab of Finance Configuration 
Maintenance. See Synergetic Financial Configuration - Business Units - 
Sales sub-tab - Page 4 sub-tab in the Finance manual.  

 
Delete the stock record for the selected business unit. 

Note: A stock record can only be deleted if the item has a zero stock 
balance. 

Alternatively, a stock item can be set to inactive; that is, logically deleted. 

See  below. 
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Button Description 

 
Set the stock item to inactive. 

Any inactive stock items are excluded from being available on the Sales 
Entry window. See Selecting stock items for sale (on page 74). For 
example, there may have been a change to the uniform and any remaining 
stock of the old uniform is set to inactive so that it is no longer available for 
sale. 

You can set an item to inactive even if Synergetic is showing that stock on 
hand is positive.  

 

If this is the case, the following dialog is displayed: 

 

Also, any stock items can be searched based on whether they are active or 
not. See Searching for items (on page 7). 

 
Set the stock item to active so that it is available for sale. 

 
Create stock for this item at the business unit. See Creating 
stock items for business units (on page 24). 

This button only appears when you select a business unit that 
has no stock record for this item. 
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Creating stock items for business units 

Stock items are held at a business unit level. Normally, you create stock items for business units when 
you first set up the item. See Create New Item - Business Units window (on page 13). 

To create a stock item record for a new business unit, if it already exists for another business unit: 

1. Select Module > Sales > Item Maintenance from the main menu. 

The Set Item Search Criteria window is displayed. 

2. Clear the Business Unit field. 

Note: You clear the field so that you can find the stock item. This is because it has not been set 
up against the new business unit yet but already exists against another business unit. 

3. Select the item. See Searching for items (on page 7). 

The Item tab of the Item Maintenance window is displayed. 

4. Click the Stock tab. 

The Stock tab of the Item Maintenance window is displayed. 

5. Select the business unit you want to create the stock record for. 

If stock is not held at the selected business unit, the following message is displayed: 

 

6. Click . 

A stock record is created for this item at the business unit. 

7. Update the fields on the Stock tab. See the Key fields and buttons area on the Item 
Maintenance - Stock tab (on page 19). 
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Item Maintenance - Suppliers tab 
Use the Suppliers tab to: 

 maintain information about the normal suppliers of the item 

 maintain the item code used by the supplier for the item. 

Opening the Suppliers tab 

To open the Item tab: 

1. Select Module > Sales > Item Maintenance from the main menu. 

The Set Item Search Criteria window is displayed. 

Tip: You can also access the Sales functions by clicking . 

2. Select the item. See Searching for items (on page 7). 

The Item tab of the Item Maintenance window is displayed. 

3. Select the Suppliers tab. 

4. The Suppliers tab of the Item Maintenance window is displayed. 
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Item Maintenance - Suppliers tab key fields and buttons 

Grid area fields 

Field Description 

Supplier Name of the supplier of the item. 

ID Synergetic ID for the: 

 supplier that you normally order this stock item from  

 owner of the stock if this is a consignment item.  

You can either: 

 type in the Creditor ID, if known 

 click  to select the supplier using the Creditor Search 
window. 

Supplier Item Code Supplier's code for the item. This is useful for reordering stock items 
because you can easily provide the codes that the supplier accepts. 

Buttons 

Field Description 

 
Launch Creditor Maintenance for the selected supplier. 

 
Move the selected entry one place higher in the grid. Creditors higher in the 
grid have a higher priority when ordering this item. 

  
Move the selected entry one place lower in the grid. Creditors lower in the 
grid have a lower priority when ordering this item. 

 
Launch the Creditor Search window to search for or create a new creditor 
to add to the grid. 

 
Delete the selected supplier from the grid. 
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Item Maintenance - Receipts tab 
When stock is delivered to a business unit you can record the delivery as a receipt. 

Use the Receipts tab to: 

 view summary information about stock receipts 

 receive stock either: 

– purchased from a supplier 

– acquired as consignment stock. 

 maintain stock receipts 

 view stocktake adjustments. 

Also, see the Item Maintenance - Stock tab (on page 19) to manage stock and add receipts. 

If configured, receipts can also be processed against: 

 Purchase orders. See Receiving goods against a purchase order in the Purchase orders 
manual. 

 Supplier invoices. See Receiving items using the Order Details tab in the Creditors manual. 
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Opening the Receipts tab 

To open the Receipts tab: 

1. Select Module > Sales > Item Maintenance from the main menu. 

The Set Item Search Criteria window is displayed. 

Tip: You can also access the Sales functions by clicking . 

2. Select the item. See Searching for items (on page 7). 

The Item tab of the Item Maintenance window is displayed. 

3. Click the Receipts tab. 

The Receipts tab of the Item Maintenance window is displayed. 
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Item Maintenance - Receipts tab key fields and buttons 

Grid area fields 

Field Description 

Date Date the goods were received. 

Qty Rcvd Unit quantity received. For example, if you receive 5 boxes of pencils and 
each box contains 25 units (individual pencils) the Qty Rcvd is 125. 

Unit Cost Unit cost for the purchased item. 

Qty Stock Units of stock received. 

Note: This is usually equal to Qty Rcvd. 

Extended Cost Extended cost of the goods supplied, calculated by multiplying the quantity 
received and the unit cost. 

Order No Purchase order number. 

Line Line number on the purchase order. 

Creditor ID and name Synergetic identifier and name of the; 

 supplier that you normally order this stock item from  

 owner of the stock if this is a consignment item. 

TransactionCode Transaction code of the receipt, indicating whether it is an adjustment or a 
standard receipt. This code is written after a stocktake is closed off. 

AdjustmentSubCode Code indicating the type of adjustment, if applicable. 

Stocktake Flag Indicates whether the selected record exists against a closed off 
stocktake. 

Post Src How the amount was paid. For example: 

 DEBCHG is offset to your debtors account 

 CRDINV is paid using Creditors. 

Post No Posting number of the creditor's invoice on debtor charges posting. 

Invoice Number If the invoice has been received, the invoice number and date is 
populated. 

Delivery Docket No The docket number for the order's delivery. 

Comment Comment for the receipt. 

Seq Field Description 

 ItemReceipt Unique identifier generated for the receipt. 

 CreditorTrans Creditor transaction identifier generated for the invoice. 

 ItemStocktake Identifier linking stocktake to the relevant journal entry. 

 GL Journal Identifier generated for G/L allocations when goods are 
received. 
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Buttons 

Button Description 

 
Add a new stock receipt. See Manually receipting stock (on page 134). 

 
Modify an existing stock receipt. 

 

The Modify Stock Receipts window is almost identical to the Receive Item 
Stock window. See Manually receipting stock (on page 134). 

 
Delete the highlighted stock receipt. 

 
Transfer stock to another business unit. 
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Item Maintenance - Stock at Business Units tab 
Use the Stock at Business Units tab to show stock held at your organisation for the selected item, by 
business unit. 

Note: This tab does not appear if the stock is on consignment. It is replaced by the Payment tab. 

Opening the Stock at Business Units tab 

To open the Stock at Business Units tab: 

1. Select Module > Sales > Item Maintenance from the main menu. 

The Set Item Search Criteria window is displayed. 

Tip: You can also access the Sales functions by clicking . 

2. Select the item. See Searching for items (on page 7). 

The Item tab of the Item Maintenance window is displayed. 

3. Click the Stock at Business Units tab. 

The Stock at Business Units tab of the Item Maintenance window is displayed. 

 



Sales Maintaining items 

Page 17-32 Version 65.19 

 

Item Maintenance - Stock at Business Units tab key fields 

Grid area fields 

Field Description 

Business Unit / 
Business Unit 
Description 

Business unit that stock is held for. 

Stock Stock on hand at the business unit, for the selected item. 

Unit Price Unit price that the business unit sells the stock item for. 

Responsible Person 
/ Phone 

Person accountable for the stock at the business unit and their phone 
number. 
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Item Maintenance - Payment tab 
Use the Payment tab to view details of consignment stock payments. 

Note: This tab is replaced by the Stock at Business Units tab if the stock is not on consignment. 

Opening the Payment tab 

To open the Payment tab: 

1. Select Module > Sales > Item Maintenance from the main menu. 

The Set Item Search Criteria window is displayed. 

Tip: You can also access the Sales functions by clicking . 

2. Select the item. See Searching for items (on page 7). 

The Item tab of the Item Maintenance window is displayed. 

3. Click the Payment tab. 

The Payment tab of the Item Maintenance window is displayed. 
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Item Maintenance - Payment tab key fields 

Fields 

Field Description 

Paid Selected if the consignor has been paid. 

Sale Number 

 

Reference to the docket that records the sale. 

This value is blank if the goods are not yet sold. 

Line Number Reference to the docket that records the sale. 

This value is blank if the goods are not yet sold. 

Manual Cheque 
Number  

Enter payment details if consignment stock payments are not used to pay 
the consignor. 

Date Enter payment date if consignment stock payments are not used to pay the 
consignor. 

Grid area fields 

Field Description 

Date Date of payment. 

Amount Amount paid to consignor. 

Commission Sales commission retained by your organisation. 

Post Src How the amount was paid. For example: 

 DEBCHG is offset to your debtor account 

 CRDINV is paid using Creditors. 

Post No Posting number of the creditor's invoice on debtor charges posting. 

Chq No Cheque number of the payment. 

Chq Date Date of the cheque received for payment. 

EFT Post No Posting number of the EFT (electronic funds transfer) payment. 

Pay Seq Unique identifying number for the payment. 

Trans Seq Unique identifying number for the transaction. 

ID ID of the creditor. 
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Item Maintenance - Sales tab 
Use the Sales tab to view sales of stock items by business unit. 

Opening the Sales tab 

To open the Sales tab: 

1. Select Module > Sales > Item Maintenance from the main menu. 

The Set Item Search Criteria window is displayed. 

Tip: You can also access the Sales functions by clicking . 

2. Select the item. See Searching for items (on page 7). 

The Item tab of the Item Maintenance window is displayed. 

3. Click the Sales tab. 

The Sales tab of the Item Maintenance window is displayed. 

 

4. Select the business unit you are viewing sales for. 

Note: You only need to select the business unit if stock is maintained in separate business units at 
your organisation. 
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Item Maintenance - Sales tab key fields and buttons 

Fields 

Field Description 

Business Unit Select the business unit to view sales for the selected item. 

To configure business units, see the Synergetic Financial Configuration - 
Business Units tab in the Finance manual. 

Charged Sales Select to display sales that have been closed off. 

Un-Charged Sales Select to display sales that have not been closed off. 

Grid area fields 

Field Description 

Pay Mthd Method of payment for the sale of the stock item. This is usually cash, credit, 
cheque, general ledger or debtor invoice. 

Chg ID Synergetic identifier of the debtor charged for the sale of the selected item. 

Name Name of the debtor charged for the sale of the selected item. 

Cust ID Customer identifier and name of the community member you sold the 
selected stock item to. 

The customer details are always displayed; however the debtor details are 
only displayed if the debtor was charged for the sale. 

Name Name of the community member you sold the selected stock item to. 

Date Date of the sale. 

Business Unit Business unit the item was sold from. 

Qty Number of items sold. 

Unit Price Price per unit for the item. 

Tax Code Code for the tax treatment for this item. 

Tax Amt Amount of tax calculated based on the unit price, quantity and tax code. 

Disc Discount amount based on the percentage or dollar amount applied to the 
stock item. 

Ext Price Price for the number of this stock item being bought in this transaction, after 
discount. 

Ext Cost Wholesale cost of the sale. 

Oride Description Description of item sale. 

Charged Identifies whether the sale has been processed via the sales close off. 

Sale Seq Unique identifier used by Synergetic for the sale. 

Line Line number within the sale. For example, line 2 is the second lot of goods in 
the sale. 

Operator Operator who conducted the sale. 
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Buttons 

Button Description 

 
Launch into Debtor Maintenance for the highlighted sale, if the sale was 
charged to a debtor.  

See Maintaining debtors in the Debtors manual. 
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Item Maintenance - Purchase Orders tab 
Use the Purchase Orders tab to view purchase orders for stock items by business unit. 

Opening the Purchase Orders tab 

To open the Purchase Orders tab: 

1. Select Module > Sales > Item Maintenance from the main menu. 

The Set Item Search Criteria window is displayed. 

Tip: You can also access the Sales functions by clicking . 

2. Select the item. See Searching for items (on page 7). 

The Item tab of the Item Maintenance window is displayed. 

3. Click the Purchase Orders tab. 

The Purchase Orders tab of the Item Maintenance window is displayed. 
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Item Maintenance - Purchase Orders tab key fields and buttons 

Fields 

Field Description 

Business Unit Select the business unit to view purchase orders for the selected item. 

To configure business units, see the Synergetic Financial Configuration - 
Business Units tab in the Finance manual. 

Complete Orders Select to display completed purchase orders. 

The default view is to display incomplete orders. 

Incomplete Orders Clear if you do not want to display incomplete orders. 

Grid area fields 

Field Description 

Order No Purchase order number. 

Order Date Date the purchase order was raised. 

Qty Ordered Original quantity ordered from the supplier. 

Qty Supplied Quantity received via stock receipts. 

For incomplete orders, the quantity supplied is less than the quantity 
ordered. 

Creditor Name of the creditor that the stock item is purchased from. 

Invoice No If the invoice has been received, the invoice number and date are populated.

Invoice Date If the invoice has been received, the invoice date is populated. 

Delivery Date The delivery date for the order. 

Delivery Docket No The docket number for the order's delivery. 

Buttons 

Button Description 

 
Launch into Purchase Order Maintenance. 

See Maintaining purchase orders in the Purchase orders manual. 
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Item Maintenance - User Forms tab 
Use the User Forms tab to open forms that have been created at your organisation. 

To launch the program linked to the user form listed, either: 

 select the user form in the grid area and click  

 double click on the user form record in the grid area. 

Opening the User Forms tab 

To open the User Forms tab: 

1. Select Module > Sales > Item Maintenance from the main menu. 

The Set Item Search Criteria window is displayed. 

Tip: You can also access the Sales functions by clicking . 

2. Select the item. See Searching for items (on page 7). 

The Item tab of the Item Maintenance window is displayed. 

3. Click the User Forms tab. 

The User Forms tab of the Item Maintenance window is displayed. 
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Item Maintenance - User Forms tab key fields and buttons 

Grid area fields 

Field Description 

Description Description of the user form. 

Code User form code. 

# Number of records displayed. 

Buttons 

Button Description 

 
Launch the highlighted user-defined form. 
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Item Maintenance - DocMan tab 
Use the DocMan tab to view, import, export, update and delete documents, pictures and spreadsheets 
related to items.  

Also see Using document management (DocMan) in the Introduction manual.  

Opening the DocMan tab 

To open the DocMan tab: 

1. Select Module > Sales > Item Maintenance from the main menu. 

The Set Item Search Criteria window is displayed. 

Tip: You can also access the Sales functions by clicking . 

2. Select the item. See Searching for items (on page 7). 

The Item tab of the Item Maintenance window is displayed. 

3. Click the DocMan tab. 

The DocMan tab of the Item Maintenance window is displayed. 
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Item Maintenance - DocMan tab key fields and buttons 

Fields 

Field Description 

Classification Classification of the documents to be displayed. Access to documents can 
be restricted based on user security levels. 

Select the classification from the drop-down list to filter the documents 
displayed. 

Document Type Type of document. For example: 

 Microsoft Word Document 

 JPG Photo 

 Adobe Acrobat File 

 Microsoft Excel Spreadsheet. 
 

Note: The document types set up are those that are used at your 
organisation.  

Select the type of document from the drop-down list to filter the documents 
displayed. 

Description Filter the documents to those which have the typed words in the description. 

Source Reference Filter the documents to those which have the typed words in the source 
reference. 
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Grid area fields 

Field Description 

Created Date Date and time the document, spreadsheet or picture was imported into 
Synergetic. 

Classification Classification of the item.  

Classifications are maintained in the luDocumentClassification lookup 
table. See Maintaining lookup tables in the System maintenance manual. 

Description Short description of the item. 

Source Code Source of the item. Typical examples include: 

 Archive 

 Magazine 

 Newspaper 

 School Photo 

 Website. 

Document sources are maintained in the luDocumentSourceCode lookup 
table. See Maintaining lookup tables in the System maintenance manual. 

Source Date Date the item was published or received. 

Source Reference Cross-reference to the source. For example the name, issue date and page 
of a newspaper where the student's photograph appeared. 

Source Path Location of the document in the file system or URL. 

This field shows the document's original location if the file has been 
embedded in the Synergetic database.  

Type Type of document. Typical examples include: 

 DOC, DOCX (Microsoft Word document) 

 JPG (photo using the Joint Photographic Experts Group format) 

 PDF (Adobe Acrobat file) 

 XLS, XLSX (Microsoft Excel spreadsheet). 

Document types are maintained in the luDocumentType lookup table. See 
Maintaining lookup tables in the System maintenance manual. 

Seq Unique number identifying the document. 
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Buttons 

Button Description 

 
Open the highlighted item in the appropriate application to view or change the item.

For example, if you highlight a Microsoft Word document and click , 
Microsoft Word is launched to open the document. 

 
Import a document, spreadsheet, picture or link an external web page. See: 

 Linking documents using a tag list in the Introduction manual 

 Importing one or more documents in the Introduction manual. 

 

 
Export a document, spreadsheet or picture. 

To copy a document, spreadsheet or picture from the Synergetic database and 
save it in a Windows folder: 

1. Click . 

2. Browse for the folder. 

3. Click . 

 
Open the highlighted item on the DocMan tab and update the information about the 
item. 

Note: You cannot update fields if the document is a photo loaded using 
Photo Maintenance. 

 
Delete the highlighted item from the DocMan tab. 

Note: Deleting an embedded record deletes the original document, 
spreadsheet or picture from the Synergetic database. Deleting a linked 
document removes the link from the Synergetic database but does not affect 
the original document. 
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Item Maintenance - Stock Movement tab 
The Stock Movement tab is used to view information about: 

 stock ordered, supplied and sold for the item 

 the average cost of each unit of the item 

 the profit made from the item. 

You can view this breakdown for each: 

 month, including the current month to date and the current month from the previous year 

 orders created for the item 

 receipts, stocktakes and stock adjustments of the item 

 sales transactions that included the item  

 all stock movements by date. 

Opening the Stock Movement window 

To open the Item tab: 

1. Select Module > Sales > Item Maintenance from the main menu. 

The Set Item Search Criteria window is displayed. 

Tip: You can also access the Sales functions by clicking . 

2. Select the item. See Searching for items (on page 7). 

The Item tab of the Item Maintenance window is displayed. 

3. Select the Stock Movement tab. 
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4. The Stock Movement tab of the Item Maintenance window is displayed. 
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Item Maintenance - Stock Movement tab key fields 

Fields 

Field Description 

Business Unit Filter Select: 

 Show All to show stock movement for this item for all business units 
at your organisation 

 a business unit from the drop-down list to show stock movement 
only for the selected business unit. 

Start Date Select the first month and year to display. 

By Month sub-tab grid area fields 

 

Field Description 

Description Description of the period for the grid area entry. 

Month Month of the stock movement. 

Ordered / Supplied / 
Sold 

Quantity and amount in dollars of the stock item that was 
ordered/supplied/sold in the month. 

Avg Cost Per Unit 
Sold 

The average cost of the stock item per unit sold for the month period. 

Profit Amount Amount of profit made from the item in the month period. 

Profit Markup Value of markup on the item. 

Profit Gross margin Markup as a percentage of the item cost. 
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By Order sub-tab grid area fields 

 

Field Description 

Business Unit Name of the business unit. 

Order No. Number for the purchase order. 

Supplier Supplier for the item. 

Date Ordered Date that the order was placed. 

Date Required Date that the stock was listed as required. 

Date Delivered Date that the stock was delivered. 

Quantity Ordered Quantity of stock ordered. 

Quantity Supplied Quantity of stock supplied. 

Sale Price Current Current sale price for the item.  

Sale Price Projected Projected sale price for the item, based on change in cost. 

Invoice No. Invoice number for the order. 

Invoice Date Date of the invoice. 
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By Receipt sub-tab grid area fields 

 

Field Description 

Business Unit Name of the business unit. 

Order No Number for the purchase order. 

Supplier Supplier for the item. 

Date Date of the receipt. 

Quantity Supplied Quantity of stock supplied. 

Unit Cost Unit cost for the purchased item, excluding tax. 

Extended Cost Extended cost of the goods supplied, calculated by multiplying the quantity 
supplied and the unit cost. 
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By Sales Transaction sub-tab grid area fields 

 

Field Description 

Sale Date Date of the sale. 

Business Unit Business unit where the sale took place. 

Sale Seq Unique identifying number for the sale. 

Quantity Quantity of the item sold. 

Unit Price Unit cost for the purchased stock, excluding tax. 

Extended Price Unit cost for the purchased stock, including tax. 

Cost of Goods Sold Extended cost of the goods supplied, calculated by multiplying the quantity 
supplied and the unit cost. 

Profit Amount Amount of profit made from the sales transaction. 

Profit Markup Value of markup on the item. 

Profit Gross Margin Markup as a percentage of the item's cost. 

Customer Name Name of the customer for the transaction. 

Charged If selected, customer has been charged for this item. 
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By All sub-tab grid area fields 

 

Field Description 

Date / Time Date and time of the transaction. 

Business Unit Business unit where the transaction took place. 

Description Description of the transaction. 

Quantity Change Change in quantity of stock on hand. 

Stock On Hand Amount of stock. 
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Entering sales 
Use the Sales Entry function to process sales of stock items to customers of your organisation and 
handle the common exceptions. 

Sales can be either: 

 cash sales or debtor sales to community members including: 

– students 

– future students 

– parents 

– debtors 

– staff. 

 "own use" sales to internal departments whose charges are allocated to a general ledger 
account 

 cash sales to non-community members 

 cash sales without knowledge of who the customer is. 

Common stock items include books and uniforms. When stock is sold, the quantity of each item sold is 
automatically reduced from the stock on hand. See Managing stock (on page 133). 

General ledger transfers 

Stock items can be transferred internally to departments in your organisation. This is done using a 
general ledger sale. The staff member responsible for receiving the stock item is nominated when 
processing the sale. 

How to: 

 Search for a customer. See Searching for a customer (on page 62). 

 Process a regular sale. See Processing a regular sale (on page 78). 

 Edit a previous sale. See Editing a previous sale (on page 82). 

 Resume a sale previously put on hold. See Resuming a held sale (on page 84). 

 Process returned goods. See Processing customer returns (on page 87). 

 Handle invalid payments. See Handling invalid payments (on page 89). 

 Perform a price enquiry while processing a sale. See Performing a price enquiry (on page 90). 

 Process a general ledger or "own use" sale. See Processing a general ledger or "own use" 
sale (on page 91). 

 Create sale charges. See Closing off sales (on page 107). 

 Print off a daily sales report. See Key sales reports (on page 223). 
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What you can do: 

What you can do… See… 

You can: 

 select a customer 

 search for a previous sale 

 search for a sale on hold 

 open the cash draw 

 reprint a docket. 

Using the New Sale window (on page 55) 

You can: 

 select stock items for sale 

 search for a customer 

 process a regular sale 

 apply discounts to individual items 

 edit a previous sale 

 place a sale on hold 

 resume a held sale 

 process a customer return 

 handle invalid payments 

 perform a price enquiry 

 process a general ledger or "own use" sale. 

Using the Sales Entry window (on page 63) 

At the conclusion of the sales process: 

 apply discounts off the entire invoice amount

 accept cash, cheque or credit card 
payments 

 find and allocate charges to the debtor 

 find and allocate charges to the general 
ledger, which are transferred internally to 
another department. 

Selecting payment methods (on page 96) 
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Using the New Sale window 
Use the New Sale window to: 

 Select a customer. See Searching for a customer (on page 62). 

 Search for a previous sale. See Editing a previous sale (on page 82). 

 Search for a sale temporarily put on hold. See Resuming a held sale (on page 84). 

Opening the New Sale window 

To open the New Sale window: 

1. Either: 

 when starting sales entry for the first time: 

– select Module > Sales > Sales Entry from the main menu 

– select the business unit, if prompted to do so. 

 from the Sales Entry window: 

– click Accept to complete the previous sale 

– click Hold Sale to put the previous sale on hold 

– click Delete Sale to delete the previous sale 

– click Customer to edit the customer's name and address if not a community member. 

The New Sale window is displayed. 

Note: If the Enter Customer BEFORE Processing Sale field is selected in financial configuration 
maintenance, the Sales Entry window is displayed instead, and the New Sale window appears 
after a sale is accepted. See Using the Sales Entry window (on page 63). Also see Synergetic 
Financial Configuration - Business Units - Sales sub-tab in the Finance manual. 
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New Sale window - key fields and buttons 

Fields 

Field Description 

Customer ID / 
Barcode 

Identifier for the customer when entering a sale. You can: 

 leave the field blank if this is a cash sale or you want to search 
through all records of the constituency selected 

 scan the customer's barcode to input the customer number 

 type in the customer's Synergetic identifier 

 type in part or all of the customer's surname then search for 
matching records of the constituency selected. 

Note: See the buttons below for details of searching. 

Customer Name Customer's name if the customer is not a member of the Synergetic 
community. 

Address Customer's address if the customer is not a member of the Synergetic 
community. 
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Buttons 

Button Description 

 
Search for a current student using the Student Search window. 

To search for a student: 

1. Enter search criteria that you know about the student. 

2. Click . 

 

3. Select the student. 

4. Click . 

The Sales Entry window is displayed. See Using the Sales Entry window 
(on page 63). 
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Button Description 

 
Search for a staff member using the Staff Search window. 

To search for a staff member: 

1. Enter search criteria that you know about the staff member. 

2. Click . 

 

3. Select the staff member. 

4. Click . 

The Sales Entry window is displayed. See Using the Sales Entry window 
(on page 63). 
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Button Description 

 
Search for a future student using the Future Student Search window. 

To search for a future student: 

1. Enter search criteria that you know about the future student. 

2. Click . 

 

3. Select the student. 

4. Click . 

The Sales Entry window is displayed. See Using the Sales Entry window 
(on page 63). 
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Button Description 

 
Search for a Synergetic community member using the Find Name on 
Community window. 

To search for a community member: 

1. Enter search criteria that you know about the person. 

2. Click . 

 

3. Select the person. 

4. Click . 

The Sales Entry window is displayed. See Using the Sales Entry window 
(on page 63). 

 
Display a list of sales that have not yet been closed off by you or other 
operators. See Editing a previous sale (on page 82).  

 
Resume a sale previously put on hold. See Resuming a held sale (on page 
84).  

 
Check the price and the stock on hand of an item, without interrupting the 
current sales process. 

See Performing a price enquiry (on page 90). 

 
Open the cash drawer.  

Note: If you do not have a cash drawer, the button will not be displayed. 

The following window is displayed requesting the password, if it has been set.

 

Note: The password is configured using the No Sale Password field on 
the Page 2 tab of Synergetic Financial Configuration - Business Units - 
Sales sub-tab in the System maintenance manual. This can be set 
independently for each business unit at your organisation. 
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Button Description 

 
Print the docket for the last sale processed. 

 
Click if either: 

 entering a cash sale, without any values selected 

 a customer name and address is used, for customers not in the 
Synergetic community. 

 
Click if either: 

 exiting from Sales Entry 

 refreshing the New Sale window. 
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Searching for a customer 

In most instances, you need to search for a customer before entering the sale. 

Note: If you are processing a cash sale and do not want to search for a customer, click  
to continue processing without identifying the customer. 

To search for a customer: 

1. Open the New Sale window. See Using the New Sale window (on page 55). 

2. In the Customer ID/Barcode field, you can: 

 scan the customer's barcode 

 type in the customer's Synergetic identifier 

 type in all or part of the customer's surname 

 

 leave the field blank if it is a cash sale and you do not need to identify the customer. 

Tip: You can set whether it is compulsory to identify the customer before the Sales Entry window 
is displayed. See Synergetic Financial Configuration - Business Units - Sales sub-tab in the 
Finance manual. 

3. Select the type of customer.  

 

You can: 

 click Student or press F2 to search for a current student 

 click Staff or press F3 to search for a staff member, whether for personal use or as an internal 
sale to a different department 

 click Future Stu or press F4 to search for a future student 

 click Community or press F5 to search for a member of the Synergetic community 

 if the customer is not a member of the Synergetic community: 

– type in the customer name and address 

 

– click . 

The Sales Entry window is displayed. See Using the Sales Entry window (on page 63). 
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Using the Sales Entry window 
Use the Sales Entry window to manage the sale of active stock items. Only active stock items can be 
sold to customers. A stock item may have been set to inactive on the Stock tab of Item Maintenance. 
See Item Maintenance - Stock tab (on page 19). 

This topic provides general information on using the Sales Entry window, and its fields and buttons. 
You should also see: 

 Selecting stock items for sale (on page 74). 

 Searching for a customer (on page 62). 

 Processing a regular sale (on page 78). 

 Editing a previous sale (on page 82). 

 Resuming a held sale (on page 84). 

 Processing customer returns (on page 87). 

 Handling invalid payments (on page 89). 

 Performing a price enquiry (on page 90). 

 Processing a general ledger or "own use" sale (on page 91). 

Opening the Sales Entry window 

To open the Sales Entry window: 

1. Select Module > Sales > Sales Entry from the main menu. 

The Select Business Unit window is displayed if you: 

– use business units at your organisation 

– are authorised to access more than one business unit.   

 

2. Select the business unit you are selling the stock items from, if prompted to do so. 

Important Note: You can configure the business unit so that Synergetic prompts for the customer 
details either before or after the sale. The following steps assume that Synergetic is prompting for 
the customer before the sale details. See Synergetic Financial Configuration - Business Units - 
Sales sub-tab in the Finance manual. 



Sales Entering sales 

Page 17-64 Version 65.19 

 

3. Click . 

The New Sale window is displayed. 

 

4. Select the customer. See Searching for a customer (on page 62). 

Note: If you are processing a cash sale, click  to continue processing without identifying 
the customer. 

The Sales Entry window is displayed. 
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Sales Entry window - key fields and buttons 

Fields 

Field Description 

Sale is a Return of 
Goods 

Select if the customer is returning goods. 

See Processing customer returns (on page 87). 

Regular Sale / 
Internal GL Sale 

Select to make the sale: 

 a regular sale that is not entitled to internal general ledger price 
groups or general ledger payment options 

 an internal general ledger sale paid from a general ledger account. 

Note: You can only make internal sales to customers who have the 
appropriate privileges. See Synergetic Financial Configuration - 
Business Units - Sales sub-tab - Page 2 sub-tab in the Finance manual. 

Item grid area unique fields 

Most of the fields in the item grid area are displayed in the Sale Details area. 

Field Description 

On Hand Quantity of this item available for purchase before the current transaction. 

Price Group Price group selected for the sale of this item. 

Note: Synergetic automatically selects the cheapest available price 
group that the customer is entitled to. You can select another price 
group from the Price Group grid. 
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Sale Details area fields 

 
The values in the Sale Details area relate to the highlighted stock item in the grid area. 

Field Description 

Barcode Barcode number of the stock item. 

Desc Manually enter a description for the stock item, if you want to override the 
default description. This replaces the item description on the sale record. 

Note: You can select Enforce Manual Description in Item 
Maintenance if you require a unique description for the line item. See 
Maintaining items (on page 5). 

Quantity Quantity of the stock item sold. 

Unit Price Price for each individual unit of the stock item. 

For example, pens can be sold individually or as packets of 10. The unit 
price is based on which unit is being sold and the number of units. 

Tax Code Change the tax code if a different tax treatment is required for the item. 

Tax Amount of tax calculated based on the unit price, quantity and tax code. 

Discount Discount amount based on the percentage or dollar amount applied to the 
stock item. 

Extended Price Price for the number of the stock items being bought, after discount. 
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Price Groups grid area fields 

 

The Price Groups area displays all applicable price groups for the highlighted stock item, provided 
more than one price group is applicable. 

Note: You can change the price group used for an item by selecting the price group and clicking 

. An item in a regular sale can use any applicable price group that is not marked for 
internal sales, including price groups that the customer is not normally entitled to. Price groups the 
customer is not entitled to are displayed in grey font. 

 

Field Description 

Price Group 
No 

Priority of the price group. 

Price Group 
Description 

Description of the price group. 

Unit Price The unit price for this item determined by the price group. 

Tax Code The tax code for this item determined by the price group. 

GL Sale If selected, this price group is used for internal general ledger sales. 
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Buttons 

Button Description 

 

(Top left-hand 
side of window) 

Launch into Community Maintenance if the customer has been selected before 
the sale is processed. See Maintaining community members in the Community 
manual.  

 

For example, you could update the customer's contact details to include their 
mobile phone number, if you need to phone them when some new stock arrives. 

 

(Top of window) 

Change the sale date or the sales person. 

 

Select  to change the date of all subsequent sales 
until either you: 

 change the sales date 

 exit Synergetic. 

 

(Right-hand side 
of window) 

Launch into Item Maintenance for the highlighted item. See Maintaining items (on 
page 5).  

 

Tip: Press F6 to launch into Item Maintenance. 
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Button Description 

 
Add a new sales item row, then either:  

 scan the barcode on the stock item and enter the quantity 

 type in the sale item in the Details area. 
 

Note: If the customer purchases more than one of the same item, they either 
appear as separate line items or as one line item with the quantity reflecting 
the number being purchased. 
 

 
 

 
 
See the Adjust Quantity for Same Sale Item field on the Page 1 tab of 
Synergetic Financial Configuration - Business Units - Sales sub-tab in the 
Finance manual. This can be set independently for each business unit at your 
organisation. 

Note: If no item is highlighted, you do not need to click . Just use 
the drop-down fields to find the item. 

 
Delete the selected sales item. A confirmation window displays the details of the 
item to be deleted. 
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Button Description 

 
Check the price and the stock on hand of an item, without interrupting the current 
sales process. 

See Performing a price enquiry (on page 90). 

 
Open the cash drawer.  

Note: If you do not have a cash drawer, the button will not be displayed. 

The following window is displayed requesting the password, if it has been set. 

 

Note: The password is configured using the No Sale Password field on the 
Page 2 tab of Synergetic Financial Configuration - Business Units - Sales sub-
tab in the Finance manual. This can be set independently for each business 
unit at your organisation. 

 
Display the docket for the last sale made. 

 
Move to the prior row, if not already at the first record. 

 
Change the quantity for the highlighted item. 

 

 
Apply a discount, expressed as a percentage off the extended price sale, for the 
highlighted item.  

 

Note: Use the Select Payment Method window to apply a discount on the 
entire sales invoice amount. See Selecting payment methods (on page 96). 
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Button Description 

 
Apply a discount, expressed as a dollar amount off the extended price sale, for the 
highlighted item. 

 

Note: Use the Select Payment Method window to apply a discount on the 
entire sales invoice amount. See Selecting payment methods (on page 96). 

 
Select a stock item manually. See Selecting stock items for sale (on page 74). 

The Stock Item Search window is displayed if the Barcode field is blank. 

 

If an existing line item is selected, click  twice. The first time, to add a new 
row and the second time to display the Stock Item Search window. 

 
Lock in the changes made to the highlighted line item. 

 
Change the price group used for this item to the selected price group. 

 
Hold the sale temporarily.  

To resume the held sale, see Resuming a held sale (on page 84). 

Note: Items in a held sale are removed from stock levels. 
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Button Description 

 
Either: 

 search for the customer, if they are a community member 

 type in their name and address if they are not a community member. 

 

Note: If the customer belongs to a price group that changes the price of the 
item, a warning label is displayed. 

 

 
Delete the current sale being processed, if you have security rights to do so. A 
confirmation window displays the total sale amount. 

 

Note: You can only delete a sale if your group's delete rights have been set 
using the Inv | InvoiceSalesEntry resource. See Group/User Security 
Maintenance - Groups View in the System maintenance manual. 

 
Accept the sale details and process the payment. 

See Selecting payment methods (on page 96). 
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Button Description 

 
Exit from the sale. 

Note: You only use this button if Synergetic is configured to prompt for the 
customer details after the sale details, and no items have been added to the 
sale. 
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Selecting stock items for sale 

Use the Stock Item Search window to manually search and select stock items for sale. Only active 
items are available; stock items that have been set to inactive on the Stock tab of Item Maintenance 
are excluded. See Item Maintenance - Stock tab (on page 19). 

Note: This window is not used when scanning the barcode of a stock item; Synergetic looks up 
and selects the item automatically. 

The Stock Item Search window is displayed when you click  on the Sales Entry window and 
the barcode field is blank. See Using the Sales Entry window (on page 63). 

 

Note: To search for items that are grouped together as a kit, search for the placeholder item code 
or description of the kit. Item kits are defined in the luItemKitComponents lookup table. See 
luItemKitComponents lookup table in the Finance manual. 
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Stock Item Search window - key fields and buttons 

Fields 

Field Description 

Business Unit Currently selected business unit. 

Item Lookup Search for stock items based on their item lookup values. 

Description Type part or all of the description of the stock item.  

You can search for items using wildcards. See Using wildcards to search in 
the Introduction manual. 

Item Code Type the item code. 

Category Select a category for a group of items. 

The values are maintained in the luItemCategory lookup table. See 
Maintaining lookup tables in the System maintenance manual. 

Size Type the size of the stock item. For example, uniform items of a certain size.

In Stock Items only Select to only include items with positive Stock On Hand.  

Clear to include all items, including non-stocked items and stock items that 
have zero or negative Stock On Hand. For example, your organisation may 
provide services or goods that you order in on behalf of students, such as 
musical instruments. These will be included. 

Include 
Consignment Stock 

Select to include items with the Consignment Stock Items flag selected on 
the Item tab of Item Maintenance. See: 

 Item Maintenance - Item tab (on page 16) 

 Create New Item - Create Item window (on page 11). 

The supplier owns consignment stock until you sell it on their behalf. For 
example, second-hand uniforms and books can be on consignment. When 
you sell the items, you remit money to the person selling the items, less a 
commission for handling. 

Clear to include only non-consignment stock items. That is, items that you 
own or services that you provide that you 'on sell' to your customers. 

Customer Detail area fields 

Field Description 

ID Synergetic ID for the customer. 

Name Name of the customer. 

Internal GL Sale Selected if the sale is an internal general ledger sale. 
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Pricing area fields 

Note: Pricing information for an item can be adjusted on the Stock tab of Item Maintenance. 
 

Field Description 

Default Price Select to display the default unit price for the item.  

Best Price for 
Customer 
Constituency 

Select to display the lowest unit price available for the item based on the 
selected customer's constituency. For example, applying any special student 
prices if applicable. 

All Prices Select to display all price groups available for the items displayed. 

Grid area fields 

Field Description 

Code Unique code for the item. 

Description Description for the item. 

Unit Price Price for each individual unit of the stock item. 

For example, pens can be sold individually or in packets of 10. The price is 
based on which unit is being sold and the number of units. 

Price Group Default price group for the item. 

Stock Quantity of stock on hand at the business unit. 

Lookup Defaults to the item description.  

Tip: You can change this in Item Maintenance to assist you with 
searching and sorting if required. 
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Buttons 

Button Description 

 
Refresh the stock items displayed in the grid area, based on the values 
entered in the Search Criteria fields. 

 

Note: Updating some fields, such as Include Consignment Stock, 
automatically redisplays the items displayed in the grid area. 

 
Clear all search criteria fields. All items for the selected business unit are 
displayed in the grid area. 

 
Select the highlighted item and return it to the previous window. 

 
Cancel the operation and return to the previous window. 
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Processing a regular sale 

The following procedure summarises the steps required to process a regular sale. For more 
information, select the relevant topic indicated. 

1. Open the New Sale window. See Using the New Sale window (on page 55). 

The Select Business Unit window is displayed if you are authorised to access more than one 
business unit. 

 

2. Select the business unit you are selling from. 

Note: Business units currently undergoing stocktake are displayed in red. 

The New Sale window is displayed. 

Note: If your organisation is configured to request customer details at the end of a sale, this 
window appears after accepting a sale. See Synergetic Financial Configuration - Business Units - 
Sales sub-tab in the Finance manual. 

 

3. Select the customer. See Searching for a customer (on page 62). 

The Sales Entry window is displayed. 

Note: If the selected business unit is currently undergoing stocktake, Stocktake in progress is 
displayed in red. 
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4. Add the stock items being sold and apply discounts at each line item, if any. See Using the Sales 
Entry window (on page 63). 

 

Note: A photo of the customer is displayed after you have selected the customer name, if a photo 
is available. If Synergetic is configured so that you have to select the customer before you process 
the sale, the photo is displayed on the Sales Entry window. Otherwise it appears on the Payment 
Method window. 

5. Click . 
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The Select Payment Method window is displayed. 

 

Note: These payment methods are defined in the Sale Payments sub-tab of the Business Units 
tab of the Finance Configuration Maintenance window. To customise payment method options 
see Synergetic Financial Configuration - Business Units - Sale Payments sub-tab in the Finance 
manual. 

6. Apply overall discounts and select the payment method. See Selecting payment methods (on 
page 96). 

Note: The Change Required window is displayed if more cash than required is given to you and 
you entered that amount in the Amount to Pay field. 
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7. Print the sales docket for the customer. 

 

Note: The sales docket is printed automatically if the Auto Produce Docket for Sale field is 
selected in Finance Configuration Maintenance. See Synergetic Financial Configuration - 
Business Units - Sales sub-tab - Page 2 sub-tab in the Finance manual. 
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Editing a previous sale 

To edit a sale that has not yet been closed off or reprint a docket: 

1. Open the New Sale window. See Using the Sales Entry window (on page 63). 

The New Sale window is displayed. 

Note: If your organisation is configured to prompt for customer information at the end of a sale, 
open the Sales Entry window instead. Also see Synergetic Financial Configuration - Business 
Units tab in the Finance manual. 

 

2. Click . 

The Select Sale to Process window is displayed. 

 

3. Select the operator, if the previous sale was not processed from your user id. 

4. If required, select the Workstation to limit the search further. 

5. If required, select Sort by Sale Date to change from the default view. 

6. Select the sale to update. 

Note: Held sales are not selected from this window. See Resuming a held sale (on page 84). 

7. Click . 

The Sales Entry window is displayed. 

8. Update the sales entry, as required. See Using the Sales Entry window (on page 63). 
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Select Sale to Process window - key fields and buttons 

Fields 

Field Description 

Operator Person who entered the sale. Defaults to your user id. 

Workstation POS workstation that the sale was performed from. 

Sort by Sale 
Date 

View previous sales based on the sale date. 

Sort by Sale 
Creation Date 

View previous sales based on the date the sale was entered in Synergetic. 

Buttons 

Button Description 

 
Preview the sales docket in Crystal Reports or as a text file. 
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Resuming a held sale 

To resume processing a previously held sale: 

A sale may have been put on hold due to an interruption in the normal sales process. For example, a 
customer may have to go out to their car to get their purse. Putting the sale on hold enables other 
customers to be served in the meantime. 

1. Open the New Sale window. See Using the Sales Entry window (on page 63). 

The New Sale window is displayed. 

Note: If your organisation is configured to prompt for customer information at the end of a sale, 
open the Sales Entry window instead. See Synergetic Financial Configuration - Business Units 
tab in the Finance manual. 

 

2. Click . 

The Resume Held Sale window is displayed. 

 

3. Select the operator, if the previous sale was not processed from your user id. 

4. If required, select the Workstation the sale was originally processed on, to filter the sales further. 

5. If required, select Sort by Sale Date to change from the default view. 
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6. Select the sale to update. 

7. Click . 

The Sales Entry window is displayed. 

 

8. Update the sales entry, as required. See Using the Sales Entry window (on page 63). 
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Resume Held Sale window - key fields and buttons 

Fields 

Field Description 

Operator Person who entered the sale. Defaults to your user id. 

Workstation POS workstation that the sale was performed from. 

Sort by Sale 
Date 

View previous sales based on the sale date. 

Sort by Sale 
Creation Date 

View previous sales based on the date the sale was entered in Synergetic. 

Buttons 

Button Description 

 
Preview the sales docket in Crystal Reports.  
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Processing customer returns 

To process a customer return: 

1. Follow exactly the same process up to step 3 for a regular sale. See Processing a regular sale (on 
page 78). 

2. On the Sales Entry window, select Sale is a Return of Goods. 

 

3. Add the item being returned. 

The sale quantity for the item defaults to -1. 

4. Repeat step 3 for each item being returned. 

5. Click . 
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The Select Payment Method window is displayed. 

 

6. Select the payment method by which the refund is being returned to the customer. See Selecting 
payment methods (on page 96). 
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Handling invalid payments 

To correct the details of a sale where the payment details were either missing or incorrectly allocated: 

1. Make a note of the details of invalid payments, if the following screen is displayed when entering 
or exiting the Sales Entry function. 

 

2. Select the sale to edit. See Editing a previous sale (on page 82).  

The Sales Entry window is displayed. 

3. Either: 

 Complete the sale. See Using the Sales Entry window (on page 63). 

 Delete the sale on the Sales Entry window. 
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Performing a price enquiry 

You can perform a price enquiry without interrupting the current sale from either the: 

 New Sale window 

 Sales Entry window. 

This provides you with the price, including any taxes, and the stock on hand for a selected item. 

To perform a price enquiry: 

1. Click  on either the: 

 New Sale window 

 Sales Entry window. 

The following window is displayed. 

 

2. Either: 

 scan the barcode of the item 

 type in the barcode of the item and click . 

The following window is displayed. 

 

3. Click  to return to the previous window. 
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Processing a general ledger or "own use" sale 

Stock items can be transferred internally to departments in your organisation. This is done using a 
general ledger sale. 

The following procedure outlines the steps required to process a general ledger sale by nominating 
the staff member. This is also known as an "own use" sale. 

1. Open the New Sale window. See Using the New Sale window (on page 55). 

The Select Business Unit window is displayed if you are authorised to access more than one 
business unit. 

 

2. Select the business unit you are processing the sale from. 

The New Sale window is displayed. 

 

Note: If your organisation is configured to prompt for customer information at the end of a sale, 
open the Sales Entry window instead. See Synergetic Financial Configuration - Business Units 
tab in the Finance manual. 

3. Search for the staff member responsible for receiving the stock item. See Searching for items (on 
page 7). 

Tip: You can enter part of the staff member's name and then press F3. 

 

4. Select the staff member from those listed on the Staff Search window. 

The Sales Entry window is displayed. 
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5. Add the stock items that are being set aside for your organisation's own use. See Using the Sales 
Entry window (on page 63). 

 

Note: A photo of the staff member is displayed after you have selected them, if a photo is 
available. If Synergetic is configured so that you have to select the staff member before you 
process the sale, the photo is displayed on the Sales Entry window. Otherwise, it appears on the 
Payment Method window. 

6. Click . 
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The Select Payment Method window is displayed. 

 

Note: The amount to be charged to the cost centre is shown highlighted in the example above. 
This figure is the ex-tax price as it an internal sale. 

7. Click . 

The Payment Detail window is displayed. 
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8. Either: 

 select the G/L Code from the drop-down list 

 right click on the G/L Code field and click Find G/L Code... to search for the G/L code. 

 

9. Select the G/L Sub-Allocation Code, if required. 

10. Click . 

11. Print the sales docket, if needed. 

Note: The sales docket is printed automatically if the Auto Produce Docket for Sale field is 
selected on Finance Configuration Maintenance. See Synergetic Financial Configuration - 
Business Units - Sales sub-tab - Page 2 sub-tab in the Finance manual. 

You can check the corresponding journal entry on the Journals tab of General Ledger Maintenance 
after you have closed off the sale. See General Ledger Maintenance - Journals tab in the General 
ledger manual. The Tax Code is set to N to prevent it from appearing on the Business Activity 
Statement (BAS) or GST return, as it should not be treated as a regular sale.  
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The sale can also be viewed on the Department Sales Summary report. See Key sales reports (on 
page 223). 
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Selecting payment methods 
At the conclusion of the sales process, you select the payment methods used by the customer. 

Use the Select Payment Method window to: 

 apply discounts off the entire invoice amount 

 accept cash, cheque or credit card payments 

 find and allocate charges to the debtor 

 find and allocate charges to the general ledger, which are transferred internally to another 
department. 

Payment for the sale can be split between payment methods. 

1. Complete the sale. See Using the Sales Entry window (on page 63). 

The Sales Entry window is displayed with stock items the customer is purchasing. 
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2. Click . 

Tip: You can also press F12 to accept payment. 

The Select Payment Method window is displayed. A photo is displayed if a customer has been 
selected from the community database and their photo is available. 

 

3. Apply any discounts off the entire sale invoice amount if required by clicking  or 

. 

4. In the Amount to Pay field, type in the amount to allocate to the first (and possibly only) payment 
method. 

Note: You can leave the Amount to Pay the same as Sale Total if the payment is allocated to 
one payment method only. The Change Required window is displayed if more cash than required 
is given to you and you entered that amount in the Amount to Pay field. 
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5. Click the payment method required based on the customer's preferences. That is, whether paying 
by cash, cheque, credit card, EFT, charging the customer's debtor account or any combination of 
the payment methods used at your organisation. For more information, see the Key fields and 
buttons area below. 

Tip: Use the function keys once you get familiar with the Select Payment Method window. 

The Payment Detail window may be displayed, such as when entering cheque details. 

 

6. Update the payment details, if required. 
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7. Click . 

Either the: 

 sale is completed 

 Select Payment Method window is displayed, showing payments made so far. 

 

Note: Split payments are supported between cash, cheque, credit card and debtor accounts. You 
cannot split general ledger payments. The example shown above does not correspond to the 
example used in the previous steps. 
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8. Repeat steps 5 through 8 for the available payment methods, if the customer is splitting payment 
between different methods. 

The docket is printed using the docket printer or a Crystal report is displayed, depending on your 
organisation's sales configuration. 

 

Note: When the sales are closed off, any debtor charges are made to the debtor account for the 
full amount of the sale and then receipt records are generated for the portion already paid. For 
example, if a $55 purchase is paid for with $25 cash and $30 charged to the debtor account, then 
the debtor account would receive a charge for $55 and a receipt for -$25 (which is allocated 
against the charge) thereby leaving $30 still owing on the charge. The example shown above does 
not correspond to the example used in the previous steps. 
Also, each sale that contains a debtor split is raised as a separate charge. For example, four split 
sales would result in four charges posted to the debtor's account. 
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Select Payment Method window - key fields and buttons 

Fields 

Field Description 

Amount to Pay Amount to pay for the selected payment method. 

Defaults to the Sale Total field. You only need to alter this if you are 
splitting between different payment methods or if you need change 
calculated. 

Note: The Change Required window is displayed if more cash 
than required is given to you and you entered that amount in the 
Amount to Pay field. 
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Buttons 

Note: The buttons that appear in the Select Payment Method window are defined in the Finance 
Configuration Maintenance window. See Synergetic Financial Configuration - Business Units - 
Sale Payments sub-tab in the Finance manual for more information about setting up and 
configuring payment methods. 

 

Button Description 

 
Apply a discount, expressed as a percentage off the entire sale 
amount. 

 

 
Apply a discount, expressed as a dollar amount off the entire sale 
amount. 
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Button Description 

 
Use the Payment Detail window to find the debtor to allocate the 
sale to. 

 

Note: If you are selling to a student, the debtor details are 
displayed for you. 

Either: 

 type in the debtor's Synergetic identifier 

 click  to use the Debtor Search window. 

Note: The button listed here is an example only. The button 
options, labels and shortcut keys depend on your organisation's 
configuration. 

 
Use the Payment Detail window to allocate charges to the general 
ledger account and sub-allocation code. 

Use this for internal sales at your organisation where only a general 
ledger transfer takes place. 

 

Note: The net amount is displayed for general ledger transfers, 
as they do not incur any taxes because they are internal to your 
organisation. 

 

Note: The button listed here is an example only. The button 
options, labels and shortcut keys depend on your organisation's 
configuration. 
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Button Description 

 
Accept cash payment for the sales. 
 

Note: The button listed here is an example only. The button 
options, labels and shortcut keys depend on your organisation's 
configuration. 

 
For credit card payments, click either the: 

 Credit card button 

 button for the selected credit card type, such as Visa. 

The way credit cards are configured on the Select Payment window 
is set on the Sale Payments sub-tab in Finance Configuration 
Maintenance. See Synergetic Financial Configuration - Business 
Units - Sale Payments sub-tab in the Finance manual. 

Note: The button listed here is an example only. The button 
options, labels and shortcut keys depend on your organisation's 
configuration. 

 
Use the Payment Detail window to enter information about the 
cheque. 

 

 
Accept payment through the My Student Account payment system, 
if used by your organisation. 

The following dialog is displayed if there are insufficient funds 
available for the customer: 

 

Note: You can configure the My Student Account options. See 
Maintaining sales setup data in the Finance manual. 
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Button Description 

 
Delete the highlighted payment made so far, if the customer changes 
their mind about the payment method or the quantity being applied. 

 

Note: The Delete button only appears when payment methods 
have been selected. 

 

Note: The button listed here is an example only. The button 
options, labels and shortcut keys depend on your organisation's 
configuration. 

 
Hold the sale temporarily. For example, if a customer has to go to 
their car to get more cash. This allows you to continue processing 
other sales. 

 
Add comments to the payment methods of the sale.  

It is suggested that for: 

 EFT transactions you use the EFT reference generated by 
the EFT terminal 

 credit card transactions you either use the EFT reference or 
the last four digits of the credit card number. 

The following window is displayed. 

 

Click  after adding the comment, EFT reference or the last 
four digits of the credit card number. 

Note: The text on the button is displayed in bold if there is an 

existing comment. Click  to display the comment. 

 
Cancel the payment methods selected and return to the Sales Entry 
window. 
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Closing off sales 
You close off sales to: 

 reconcile the cash, EFT, cheques and credit card takings against what is expected 

 create debtor charges for sales that have not been charged for 

 transfer general ledger amounts to the correct accounts. 

Close off types are used to process groups of payment methods. For information on close off types, 
see Understanding close off types (on page 109). 

Each of the reconciliation windows are displayed in turn, depending on how the Payment Methods 
sub-tab is configured on the Finance Configuration Maintenance window at your organisation. See: 

 Sales Close Off - Close Off Type window (on page 110) 

 Sales Close Off - Individual window (on page 114) 

 Reconciling sales close offs (on page 125) 

 Synergetic Financial Configuration - Business Units - Sale Payments sub-tab in the System 
maintenance manual. 

Separate postings are created for debtor and general ledger sales. See Sales Close Off - Post window 
(on page 120). 

Debtor splits 

When the sales are closed off: 

 any debtor charges are made to the debtor accounts for the full amount of the corresponding 
sale 

 receipt records are generated for the portion already paid.  

For example, if a $100 purchase is paid for with $30 cash and $70 on the debtor account, then the 
debtor account would receive a charge for $100 and a receipt for -$30 (which is allocated against the 
charge) thereby leaving $70 still owing on the charge. 

Also, each sale that contains a debtor split is raised as a separate charge. For example, four split 
sales for one customer would result in four charges posted to the debtor's account. 

How to: 

 Reconcile cash, cheques, EFT and credit card takings against what is expected. See 
Reconciling sales close offs (on page 125). 

 Handle situations when the reconciliation does not balance. See Unreconciled sales close offs 
(on page 132). 
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What you can do: 

What you can do… See… 

You can: 

 select the business unit and close off type 

 reprint postings 

 delete postings. 

Sales Close Off - Close Off Type window (on 
page 110) 

Close off individual payments for either a: 

 debtor 

 general ledger account. 

Sales Close Off - Individual window (on page 
114) 

Select the: 

 fee code for debtor charges 

 posting details 

 bank account used to bank the proceeds. 

Sales Close Off - Post window (on page 120) 
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Understanding close off types 
Close off types are used as part of Closing off sales (on page 107). A close off type groups together 
payment methods that you want to reconcile and post to the general ledger.  

Close off types 

Sales can be closed off on a periodic basis, for example: 

 daily 

 monthly 

 by term. 

A close off can also be defined to suit your organisation. For example: 

 EFTPOS payments 

 banking (cash and cheques) 

 internal categories (debtors, sales, and so on). 

Synergetic does not schedule close offs automatically. You need to process close offs at the relevant 
time. 

You can use the individual type to close off payments for: 

 debtors 

 general ledger account sales. 

No reconciliation or cash receipts are generated when an individual close off is processed. See Sales 
Close Off - Individual window (on page 114). 

Split payments 

When the sales close off contains any split payments where part of the payment is allocated to a 
debtor's account, Synergetic: 

 writes a charge for the full amount to the debtor when the daily close off is done 

 generates a receipt for the amount already paid (by cash, credit card, EFT or cheque). 

The Debtor Maintenance - History tab will show the transaction total and the amount already paid. 
These amounts appear on the next debtor statement. 

Close off types are maintained by business unit in Synergetic Financial Configuration - Business Units 
- Sale Payments sub-tab in the System maintenance manual. 
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Sales Close Off - Close Off Type window 
Use the Sales Close Off - Close Off Type window to: 

 select the business unit and close off type 

 reprint postings 

 delete postings. 

You can also close off sales for individual POS workstations. 

For information on close off types, see Understanding close off types (on page 109). 

Opening the Sales Close Off - Close Off Type window 

To open the Sales Close Off - Close Off Type window: 

1. Select Module > Sales > Sales Close Off from the main menu. 

The Sales Close Off - Close Off Type window is displayed. 

 

2. Select the Business Unit. 

3. Select the Workstation if you only want to close off sales for one workstation. 

Note: If this field is left blank, then all workstations are processed for the selected business unit. 

4. Select the Close Off Type. 

5. Click . 

Either: 

 Each of the reconciliation windows are displayed in turn, depending on how the Payment 
Methods sub-tab is configured on the Finance Configuration Maintenance window at your 
organisation. See Reconciling sales close offs (on page 125), Synergetic Financial 
Configuration - Business Units tab - Sale Payments sub-tab in the System maintenance 
manual. 

 The Sales Close Off - Post window is displayed. See Sales Close Off - Post window (on 
page 120). 
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Sales Close Off - Close Off Type window key fields and buttons 

Fields 

Field Description 

Business Unit Defaults to your default business unit but can be changed if required. 

Workstation Select a workstation if you want to close off sales for one workstation only. This 
is useful when you want to reconcile the cash, cheques, EFT and credit card 
payments for each POS workstation in turn, at the end of the day. 

If this field is left blank, then all workstations are processed for the selected 
business unit. 

Select Close Off 
Type to Process 

Close off type used for the selected business unit. 

See Understanding close off types (on page 109). 

Tip: You can display the payment methods that have been configured by 
mousing over the close off type.  
In the example below, the typical payment methods that are closed with the 
daily close off type are displayed. 

 
In the example below, the typical payment methods that are closed with the 
monthly close off type are displayed. 

 

The payment methods are defined on the Sale Payments sub-tab of Finance 
Configuration Maintenance. See Synergetic Financial Configuration - 
Business Units - Sale Payments sub-tab in the Finance manual. 
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Buttons 

Button Description 

 
To reprint the posting: 

1. Select the type of postings to view. 

2. Search for and select the required posting. 

 

3. Click . 

The Print Preview window is displayed. 

Note: You can view the posting on the screen and print it if required. 
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Button Description 

 
To delete the highlighted posting: 

1. Select the type of postings to view. 

2. Search for and select the required posting. 

 

3. Click . 

4. Confirm that you want to delete the posting. 

Important Note: If you need to delete a posting that has been closed off, make 
sure you delete all four posting types for the close off process, that is: 
     Student/Debtor Charges 
     G/L Charges 
     Receipts 
     Cost of Sale Journals. 

 
Navigate to the next window, which will depend on the selections on this window and 
the payment methods defined at your organisation. 

See: 

 Reconciling sales close offs (on page 125) 

 Sales Close Off - Individual window (on page 114) 

 Sales Close Off - Post window (on page 120). 
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Sales Close Off - Individual window 
Use the Sales Close Off - Individual window to close off individual payments for either a: 

 debtor 

 general ledger account. 

No reconciliation or cash receipts are generated. 

Opening the Sales Close Off - Individual window 

To open the Sales Close Off - Individual window: 

1. Select Module > Sales > Sales Close Off from the main menu. 

The Sales Close Off - Close Off Type window is displayed. 

 

2. Select the Business Unit. 

3. Select the Workstation if you only want to close off sales for one workstation. 

Note: If this field is left blank, then all workstations are processed for the selected business unit. 

4. Select the Close Off Type to process. 
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5. Click . 

The Sales Close Off - Individual window is displayed. 

 

6. Either: 

– select a Payment Method to Process 

– leave the Payment Method to Process field blank to process all payment methods. 

7. Clear the Process Student/Debtor Sales field if you do not want to process student or debtor 
sales. 

8. Clear the Process General Ledger Sales field if you do not want to process general ledger sales. 

9. If you want to only process a specific: 

– student, type their Synergetic ID in the Individual Student ID to Process 

– debtor, type their Synergetic ID into the Individual Debtor ID to Process 

– general ledger code, select it from the drop-down list. 

Tip: Click  to search for students or debtors if you do not know their Synergetic ID. 
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10. Click . 

The Sales Close Off - Post window is displayed. 

 

11. Update the posting details and click . 

The sales are closed and posted, and the following reports may be output from Synergetic: 

 Debtor Sale Charges report of charges to individual debtors or general debtor accounts 
(cash, cheque, EFT and credit card) 

 General Ledger Sale Charge report of general ledger journals created for internal sales 

 Cash Receipts - Closed Off report which includes receipts (cash, cheque and EFT) 

 Bank Deposit report to accompany any cash and cheques to the bank 

 Close Off Reconciliation summary report 

 Cost of sales report. 

The following window is displayed if the business unit is configured to generate invoices. 
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12. Click . 

The invoices are printed for the current posting and the following message is displayed. 

 

13. Click . 



Sales Closing off sales 

Page 17-118 Version 65.19 

 

Sales Close Off - Individual window key fields and buttons 

Fields 

Field Description 

Payment Method 
to Process 

Select the payment method to close off for the individual, from the drop-down list.

 

Close off types are maintained by business unit in Synergetic Financial 
Configuration - Business Units - Sale Payments sub-tab in the System 
maintenance manual. 

 

Process 
Student/Debtor 
Sales 

Select this field to close off sales that have been charged to debtor accounts. 

Individual 
Student ID to 
Process 

Either: 

 type in the student's Synergetic ID if known 

 click  to search for the student. 

Individual 
Debtor ID to 
Process 

Either: 

 type in the debtor's Synergetic ID if known 

 click  to search for the debtor. 

Process General 
Ledger Sales 

Select this field to close off sales to general ledger accounts. 

Individual G/L 
Code to Process 

Select the general ledger account to close off, from the drop-down list. 
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Buttons 

Button Description 

 (Student ID) 
Search for the student using the Student Search window. 

 

 (Debtor ID) 
Search for the debtor using the Debtor Search window. 

 

 
Navigate back to the Sales Close Off - Close Off Type window. 

See Sales Close Off - Close Off Type window (on page 110). 

 
Navigate to the Sales Close Off - Post window.  

See Sales Close Off - Post window (on page 120). 
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Sales Close Off - Post window 
Use the Sales Close Off - Post window to select the: 

 fee code and transaction date for debtor charges 

 posting details for the general ledger activity 

 bank account used to bank the proceeds. 

When the charges are processed, one charge is created for each sale for a debtor. 

Opening the Sales Close Off - Post window 

To open the Sales Close Off - Post window: 

1. Select Module > Sales > Sales Close Off from the main menu. 

The Sales Close Off - Close Off Type window is displayed. 

2. Update the settings on the Sales Close Off - Close Off Type window. See Sales Close Off - 
Close Off Type window (on page 110). 

3. Click . 

Other windows are displayed depending on how Synergetic has been configured. For example, 
you may be required to do detailed cash reconciliation. 

 

4. Perform the reconciliation for the selected payment method, if required. See Reconciling sales 
close offs (on page 125). 

5. Repeat steps 3 and 4, as required. 
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6. Click . 

The Sales Close Off - Summary window is displayed. 

 

7. Click . 

Tip: You can click  and  to change the settings on the Sales Close Off 
windows. 

The Sales Close Off - Post window is displayed. 

 

8. Update the posting details. 
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9. Click . 

The sales are closed and posted, and the following reports may be output from Synergetic: 

 Debtor Sale Charges report of charges to individual debtors or general debtor accounts 
(cash, cheque, EFT and credit card) 

 General Ledger Sale Charge report of general ledger journals created for internal sales 

 Cash Receipts - Closed Off report which includes receipts (cash, cheque and EFT) 

 Bank Deposit report to accompany any cash and cheques to the bank 

 Close Off Reconciliation summary report 

 Cost of sales report. 

The following window is displayed if the business unit is configured to generate invoices. 

 

10. Click . 

The invoices are printed for the current posting and the following message is displayed. 

 

11. Click . 
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Sales Close Off - Post window key fields and buttons 

Fields 

Field Description 

Fee Code for Debtor 
Charges 

All items on a sale are charged under one fee code for each debtor. 

The general ledger code updated for the sale is one of the following: 

 Override general ledger code set up for some items. 

 General ledger codes attached to the fee code (for debtor sales). 

Sole control account identified on the Invoicing sub-tab of Synergetic 
Financial Configuration. See Synergetic Financial Configuration - Business 
Units - Invoicing sub-tab in the Finance manual. 

Tip: You can search for fee codes by right clicking on the Fee Code 
field and selecting Find Debtor Fee Code. 

 

Date to Appear on 
Transactions 

Effective date to appear on any debtor transactions. 

Posting Date Date the postings will appear in the general ledger. 

Description Description of the sales close off. 

Bank Account Bank account used to process receipts to. 
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Buttons 

Button Description 

 
Close off the sales based on the selections made on earlier windows. 

The following reports are typically output from Synergetic: 

 Debtor Sale Charges report of charges to individual debtors or 
general debtor accounts (cash, cheque, EFT and credit card) 

 General Ledger Sale Charges report 

 Cash Receipts - Closed Off report which includes receipts (cash, 
cheque and EFT) 

 Bank Deposit report to accompany any cash and cheques to the 
bank 

 Close Off Reconciliation report 

 Cost of sales report. 

You can also print invoices for the posting, if applicable. 

 

 
Navigate back to the previous window, which will depend on your selections 
earlier and the payment methods defined at your organisation. 

See: 

 Reconciling sales close offs (on page 125) 

 Sales Close Off - Individual window (on page 114) 

 Sales Close Off - Close Off Type window (on page 110). 
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Reconciling sales close offs 

Reconciling cash 

Synergetic provides the capability to close off by workstation. For example, this enables you to 
reconcile the cash and cheques in each POS cash drawer at the end of the day. 

 

Remember to take into account the float added to the cash drawer at the start of the day, as 
Synergetic does not provide any functions for managing cash floats.  

It is common practice to hold a cash float for the next day's trading. Simply remove the cash 
equivalent to the previous night's float from the day's takings before trying to reconcile. 

If you chose not to remove the cash float from the till beforehand, take off the float figure before 
arriving at the reconciliation total. In the following example, there is $125 in the cash drawer at the end 
of the day. Taking off the $100 float added to the workstation at the start of the day, the Reconciled 
(Cash) figure of $25 (that is, $125 - $100) agrees with the Calculated (Cash) figure.  

 

Tip: Remove the cash float before reconciling the cash amounts. The float is returned to the cash 
drawer before the next day's sales. 
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Reconciling payments 

The following example demonstrates a typical process for reconciling a daily sales close off. The 
actual process used at your organisation depends on what has been configured and which close off 
type is selected. 

In the example, the following payment methods are used: 

 Cash, with either summary reconciliation or detailed reconciliation outlined for this payment 
method 

 VISA Card, outlining the reconciliation of payments by credit card 

 Cheque, outlining the reconciliation of payments by cheque. 

Some payment methods, such as EFT, can be set to automatically reconcile and therefore a 
reconciliation window does not appear for the payment method. 

To reconcile payments made for each payment method, for the selected close off type: 

1. Select Module > Sales > Sales Close Off from the main menu. 

The Sales Close Off - Close Off Type window is displayed. 

2. Update the settings on the Sales Close Off - Close Off Type window. See: 

 Understanding close off types (on page 109) 

 Sales Close Off - Close Off Type window (on page 110). 
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3. Click . 

The Sales Close Off window is displayed for the first payment method, Cash in this example. The 
Sales Close Off - Cash window is either displayed in summary or detailed as shown in the 
following examples, respectively. 

 

Note: The payment methods for each close off type, and whether summary or detailed 
reconciliation, are configured on the Finance Configuration Maintenance window. See 
Synergetic Financial Configuration - Business Units - Sale Payments sub-tab in the Finance 
manual. 

4. Reconcile the cash, if the Sales Close Off - Cash window is displayed. Either enter the: 

 reconciled amount in the Reconciled (Cash) field, if the summary window is displayed 

 quantity of each type of note or coin, if the detailed window is displayed. 

Note: The Calculated field is the total sales allocated to the payment method since it was last 
closed off, and should equal the Reconciled field. The Reconciled field is debited to the 
nominated bank account once closed off. 

Tip: You can reconcile and close off the cash for each POS workstation in turn. Do not forget to 
take into account the float used at the start of the day, if you have not removed the cash float 
already. 
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5. Click . 

The Sales Close Off window is displayed for the next payment method defined, EFT in this 
example. 

 

6. Click  if there are no payments for this payment method and no reconciliation is 
required. 

The Sales Close Off window is displayed for the next payment method defined, VISA Card in this 
example. 

 

7. Reconcile each receipt for the selected payment method, if the detailed window is displayed. 
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8. Select the Reconciled field next to the corresponding entry on the window. 

 

9. Repeat steps 7 and 8 for each receipt. 

The Reconciled (VISA Card) field is updated with the sum of all reconciled payments to date. 

 

10. Click . 

The Sales Close Off window is displayed for the next payment method defined, Cheque in this 
example. 

 

11. Reconcile each cheque, if the detailed window is displayed. 

12. Select the Reconciled field next to the corresponding entry on the window. 
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13. Repeat steps 11 and 12 for each cheque. 

The Reconciled (Cheque) field is updated with the sum of all reconciled payments to date. 

 

14. Click . 

The Sales Close Off - Summary window is displayed. 

 

15. Click . 

The Sales Close Off - Post window is displayed.  

Update the selections on the Sales Close Off - Post window. See Sales Close Off - Post window 
(on page 120). 
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16. Click . 

The sales are closed and posted, and the following reports may be output from Synergetic: 

 Debtor Sale Charges report of charges to individual debtors or general debtor accounts 
(cash, cheque, EFT and credit card) 

 General Ledger Sale Charges report of general ledger journals created for internal sales 

 Cash Receipts - Closed Off report which includes receipts (cash, cheque and EFT) 

 Bank Deposit report to accompany any cash and cheques to the bank 

 Close Off Reconciliation report 

 Cost of sales report. 

The following window is displayed if the business unit is configured to generate invoices. 

 

17. Click . 

The invoices are printed for the current posting and the following message is displayed. 

 

18. Click . 
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Unreconciled sales close offs 
If there is a variation between the amounts held and the computer record, the difference is transferred 
to the debtor's account, as specified against the payment type. Finance staff need to create a debtor 
charge to record any profit or write off a cash loss. 

For example, if you should have $1,011 cash but actually have $1,005, the $6 difference is reflected in 
the cash sale debtor account. Finance staff will create a debtor charge to write off the $6. 

If the amount of a cheque is wrong: 

1. Clear the Reconciled field against the cheque, otherwise the bank deposit will be wrong. 

 

2. Let the Finance staff know. They need to receipt the cheque manually. 
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Managing stock 
Most organisations have several business units that sell stock and services. For example, the uniform 
shop and book room. 

Synergetic allows you to manage stock, both purchased and/or on consignment for each business 
unit. 

Examples of business units are: 

 Uniform shop 

 Book room 

 Music department. 

Each business unit has its own physical stock holdings. An item can be used across all business units, 
such as packets of 20 pencils. The stock level for the packets of pencils is recorded for each business 
unit. 

How to: 

 Receipt stock from suppliers or when on consignment. See Manually receipting stock (on 
page 134). 

 Pay suppliers, such as parents, for consignment stock sold on their behalf. See Making 
consignment stock payments (on page 160). 

 Perform a stocktake of items. See Stocktaking items (on page 170).  
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Manually receipting stock 
Based on how business units are configured, stock is: 

 received manually 

 integrated with creditor invoice entry 

 integrated with purchase order receipts. 

Use the Receive Item Stock window to manually receipt stock into the business unit. 

After entering a stock receipt: 

 the stock level is adjusted 

 a new receipt record is created 

 the average cost field is updated. 

Note: Receipting stock has no effect on the general ledger. Enter a general ledger journal if you 
need to record financial transactions. 

Opening the Receive Item Stock window 

To open the Receive Item Stock window: 

1. Either open the: 

 Item Maintenance - Stock tab (on page 19), then click . 

 Item Maintenance - Receipts tab (on page 27), then click .  

The Receive Item Stock window is displayed. 
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Receive Item Stock window - key fields and buttons 

Fields 

Field Description 

Business Units Select the business unit to receive stock for the selected item. 

To configure business units, see the Synergetic Financial Configuration - 
Business Units tab in the Finance manual. 

Date Date the goods were received. 

Quantity Quantity received. 

Important: The Quantity and Unit Cost fields affect the average cost of 
the item. 

Unit Cost Unit cost for the purchased item, excluding tax. 

Warning: If you do not know the actual unit cost when processing 
purchase order receipts, this can change the average cost. For example, 
this occurs if goods are received using a delivery docket instead of an 
invoice. The last receipt cost or average cost is used rather than the 
actual unit cost. 

Note: A negative unit cost cannot be entered. 

Extended Cost Extended cost of the goods supplied, calculated by multiplying the quantity 
supplied and the unit cost. 

Creditor ID Synergetic identifier for the: 

 supplier that you normally order this stock item from 

 owner of the stock if this is a consignment item. 

Note: To populate the Creditor ID field, click  and select the 
creditor using the Creditor Search window. 

Order Number Purchase order number. 

Line Line number on the purchase order. 

Buttons 

Button Description 

 
Select the supplier using the Creditor Search window. 
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Stock Summary window 
Use the Stock Summary window to view details about stock held by your organisation.  

What you can do: 

What you can do… See… 

View details about items with low stock. Stock Summary - Low Stock tab (on page 
137) 

View details about creditors who have supplied items 
in the past, including: 

 'normal' suppliers for an item 

 previous purchase orders for an item 

 the most recent purchase order made to a 
supplier. 

Stock Summary - Suppliers for Stock tab (on 
page 139) 

View the movement of a selected item by: 

 month 

 order 

 receipt 

 sales transaction 

 all of the above. 

Stock Summary - Stock Movement tab (on 
page 144) 

View details of purchase orders for selected stock 
items. 

Stock Summary - Purchase Orders tab (on 
page 151) 

View detailed information about sales, pricing and 
profit margins for: 

 a date range 

 a business unit 

 an item category 

 a particular item. 

Stock Summary - Sales Analysis tab (on page 
154) 

View information about purchases for: 

 a date range 

 a business unit 

 an item category 

 a particular item. 

Stock Summary - Purchases Analysis tab (on 
page 157) 

 
 



Managing stock Sales 

Version 65.19 Page 17-137 

Stock Summary - Low Stock tab 

The Low Stock tab is used to view items that have a stock level equal to or less than their reorder 
level for selected business units. 

Opening the Low Stock tab 

To open the Low Stock tab: 

1. Select Sales > Stock Summary from the Synergetic main menu. 

Tip: You can also access the Sales functions by clicking . 

The Low Stock tab of the Stock Summary window is displayed. 

 

Stock Summary - Low Stock tab key fields and buttons 

Fields 

Field Description 

Active Filter Select either: 

 Active Only to display only active low stock 

 Inactive Only to display only inactive low stock 

 All to display all low stock. 

Business Unit Filter 

 

Select either: 

 Show All to display items for all business units 

 a business unit from the drop-down list to display items for the 
selected business unit. 

Include Items with 
zero reorder quantity 

Display low stock items with a reorder quantity of zero in the grid. See Item 
Maintenance - Stock tab (on page 19) for information about reorder quantity.
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Grid area fields 

Field Description 

Business Unit Business unit where the stock is located. 

Item Description Description for the item. 

Item Code Item code. 

Item Category Item category. 

Stock On Hand Quantity of stock on hand at the business unit. 

Stock Reorder Level Reference figure used to nominate the stock level below which you need to 
reorder more stock. 

Stock Reorder 
Quantity 

Reference figure used to nominate the amount of stock reordered, when the 
stock level falls below the Reorder Level value. 

Normal Supplier 
Name 

Name of the supplier of the item. 

Normal Supplier ID Synergetic ID for the: 

 supplier that you normally order this stock item from  

 owner of the stock if this is a consignment item.  

Normal Supplier Last 
Order No. 

Purchase order number for the last time the item was ordered. 

Normal Supplier Last 
Cost Supplied 

The cost of the item the last time the item was suppled. 

Buttons 

Button Description 

 
Launch Item Maintenance for the selected grid entry. 

 
Launch Creditor Maintenance for the supplier of the item. 

 
Launch Purchase Order Maintenance for the grid entry. 

 
Display the Suppliers for Stock tab with information for the selected grid 
record. 
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Stock Summary - Suppliers for Stock tab 

The Suppliers for Stock tab displays: 

 items sold in each of the business units at your organisation 

 creditors listed as suppliers for selected items 

 creditors who have ever supplied the selected item. 

Depending on the Order Status for the supplier, double clicking on the grid entry allows you to: 

 New - create a new purchase order for the item with the selected supplier 

 Add - add the item to an existing purchase order with the selected supplier 

 Edit - edit the item's line in an existing purchase order with the selected supplier. 

Opening the Suppliers for Stock tab 

To open the Suppliers for Stock tab: 

1. Select Sales > Stock Summary from the Synergetic main menu. 

Tip: You can also access the Sales functions by clicking . 

The Low Stock tab of the Stock Summary window is displayed. 

2. Click Suppliers for Stock. 

The Suppliers for Stock tab is displayed. 
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Stock Summary - Suppliers for Stock tab key fields and buttons 

Filter areas 

Field Description 

Business Unit Filter Select either: 

 Show All to display items for all business units 

 a business unit from the drop-down list to display items for the 
selected business unit. 

Show Low Stock 
Only 

Show only items with a stock level equal to or less than their reorder level. 
See Stock Summary - Low Stock tab (on page 137). 

Only Show Suppliers 
since 

Select to display only suppliers who have been ordered from after the 
selected date. 

Purchase history 
(months) 

Number of months used to calculate the minimum, maximum and average 
costs for the supplier.  

Items area grid fields 

Field Description 

Description Description for the item. 

Item Code Code used for the item. 

Reorder Level Reference figure used to nominate the stock level below which you need to 
reorder more stock. 

Reorder Qty Reference figure used to nominate the amount of stock reordered, when the 
stock level falls below the Reorder Level value. 

Stock on Reqsn Quantity of stock requisitioned. 

Stock on Order Quantity of stock on order. 

Stock on Deliv Quantity of stock delivered to your organisation but not yet receipted into a 
business unit. 

Stock on Hand Quantity of stock on hand. 

Note: Items with a Stock On Hand level lower than their reorder amount 
are displayed in red. 
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Grid area fields 

Field Description 

Double Click Action taken when you double click on the grid entry for the supplier: 

 Add - add the selected item to an existing purchase order 

 Edit - edit the line item for the selected item in an existing purchase 
order 

 New - create a new purchase order with this supplier containing this 
item. 

Supplier Name Name of the supplier of the item. 

Supplier Normal Selected if the supplier is listed on the Suppliers tab of Item Maintenance 
for the item. See Item Maintenance - Suppliers tab (on page 25). 

Supplier Priority Order that the supplier is listed on the Suppliers tab of Item Maintenance. 
See Item Maintenance - Suppliers tab (on page 25). 

Supplier ID Synergetic ID for the supplier. 

Order No Purchase order number. 

Order Business Unit Business unit that the purchase order is for. 

Order Delivery Date Delivery date for the stock. 

Order Status Status of the purchase order. 

Order Authorisation 
Status 

Authorisation status for the purchase order. See Purchase Order 
Maintenance - Authorisation tab in the Purchase orders manual. 

Order Line Line number of the selected item in the purchase order. 

Order Qty Ordered Quantity of the selected item ordered. 

Order Unit Cost 
Ordered 

Cost per unit as ordered for the selected item in the purchase order. 

Order Qty Supplied Quantity of the selected item supplied. 

Order Unit Cost 
Supplied 

Cost per unit as supplied for the selected item. 

Order Type Order type. See Purchase Order Maintenance - General tab in the Purchase 
orders manual. 

Order Is Last Order Selected if this order is the most recent order made to the supplier. 

 

Supplier area fields 

Note: The fields in this area are a subset of the fields in the grid area but for the following 
exceptions. 

 

Field Description 

Min Cost Supplied Minimum cost that the supplier has sold the item to your organisation for. 

Max Cost Supplied Maximum cost that the supplier has sold the item to your organisation for. 
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Buttons 

Button Description 

 
Apply the criteria selected in the Filters area to refresh the results displayed 
in the grid area. 

 
Launch Item Maintenance for the selected grid entry. 

 
Launch Creditor Maintenance for the supplier of the item. 

 
Launch Purchase Order Maintenance for the grid entry. 

 
Click to add the selected item to the selected existing purchase order for the 
selected supplier. The Add item to Purchase Order window is displayed. 
See Maintaining purchase orders in the Purchase orders manual. 
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Button Description 

 
Click to add the selected item to a new purchase order for the selected 
supplier. The Create New Purchase Order window is displayed. See 
Maintaining purchase orders in the Purchase orders manual. 

 

 
Click to edit an existing order of this item with the selected supplier. See 
Maintaining purchase orders in the Purchase orders manual. 
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Stock Summary - Stock Movement tab 

Use the Stock Movement tab to view the movement of a selected item by: 

 month, including the current month to date and the current month from the previous year 

 orders created for the item 

 receipts, stocktakes and stock adjustments of the item 

 sales transactions that included the item  

 all stock movements by date. 

Opening the Stock Movement tab 

To open the Stock Movement tab: 

1. Select Sales > Stock Summary from the Synergetic main menu. 

Tip: You can also access the Sales functions by clicking . 

The Low Stock tab of the Stock Summary window is displayed. 

2. Click Stock Movement. 

The Stock Movement tab is displayed. 

 

Stock Summary - Stock Movement tab key fields and buttons 

Filter areas 

Field Description 

Business Unit Filter Select either: 

 Show All to display items for all business units 

 a business unit from the drop-down list to display items for the 
selected business unit. 
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Field Description 

Start Date Earliest date shown in the grid entries. 

Orders Select: 

 Completed to show completed orders 

 Uncompleted to show uncompleted orders. 

Sales Select: 

 Charged to show charged sales 

 Uncharged to show uncharged sales. 

Grid fields 

Note: You can right click on a grid to enable filter options. 

 
 

Field Description 

Description Description of the item. 

Item Code Code for the item. 

Stock On Hand Stock present at your organisation for the item. 

By Month sub-tab grid area fields 

 



Sales Managing stock 

Page 17-146 Version 65.19 

Field Description 

Description Description of the period for the grid area entry. 

Month Month of the stock movement. 

Ordered / Supplied / 
Sold 

Quantity and amount in dollars of the stock item that was 
ordered/supplied/sold in the month. 

Avg Cost Per Unit 
Sold 

The average cost of the stock item per unit sold for the month period. 

Profit Amount Amount of profit made from the item in the month period. 

Profit Markup Value of markup on the item. 

Profit Gross margin Markup as a percentage of the item cost. 
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By Order sub-tab grid area fields 

 

Field Description 

Business Unit Name of the business unit. 

Order No. Number for the purchase order. 

Supplier Supplier for the item. 

Date Ordered Date that the order was placed. 

Date Required Date that the stock was listed as required. 

Date Delivered Date that the stock was delivered. 

Quantity Ordered Quantity of stock ordered. 

Quantity Supplied Quantity of stock supplied. 

Sale Price Current Current sale price for the item.  

Sale Price Projected Projected sale price for the item, based on change in cost. 

Invoice No. Invoice number for the order. 

Invoice Date Date of the invoice. 
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By Receipt sub-tab grid area fields 

 

Field Description 

Business Unit Name of the business unit. 

Order No Number for the purchase order. 

Supplier Supplier for the item. 

Date Date of the receipt. 

Quantity Supplied Quantity of stock supplied. 

Unit Cost Unit cost for the purchased item, excluding tax. 

Extended Cost Extended cost of the goods supplied, calculated by multiplying the quantity 
supplied and the unit cost. 
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By Sales Transaction sub-tab grid area fields 

 

Field Description 

Sale Date Date of the sale. 

Business Unit Business unit where the sale took place. 

Sale Seq Unique identifying number for the sale. 

Quantity Quantity of the item sold. 

Unit Price Unit cost for the purchased stock, excluding tax. 

Extended Price Unit cost for the purchased stock, including tax. 

Cost of Goods Sold Extended cost of the goods supplied, calculated by multiplying the quantity 
supplied and the unit cost. 

Profit Amount Amount of profit made from the sales transaction. 

Profit Markup Value of markup on the item. 

Profit Gross Margin Markup as a percentage of the item's cost. 

Customer Name Name of the customer for the transaction. 

Charged If selected, customer has been charged for this item. 
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By All sub-tab grid area fields 

 

Field Description 

Date / Time Date and time of the transaction. 

Business Unit Business unit where the transaction took place. 

Description Description of the transaction. 

Quantity Change Change in quantity of stock on hand. 

Stock On Hand Amount of stock. 

Buttons 

Field Description 

 
Launch Item Maintenance for the selected grid entry. 

 
Launch Creditor Maintenance for the supplier of the item. 

 
Launch Purchase Order Maintenance for the grid entry. 

 
Launch Community Maintenance for the selected customer. 

 
Launch the Stock Transfer window to transfer a number of the selected 
item to another business unit at your organisation. 
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Stock Summary - Purchase Orders tab 

Use Purchase Orders tab to view details of purchase orders for items. You can filter the purchase 
orders displayed by status. 

Opening the Purchase Orders tab 

To open the Purchase Orders tab: 

1. Select Sales > Stock Summary from the Synergetic main menu. 

Tip: You can also access the Sales functions by clicking . 

The Low Stock tab of the Stock Summary window is displayed. 

2. Click Purchase Orders. 

The Purchase Orders tab is displayed. 
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Stock Summary - Purchase Orders tab key fields and buttons 

Filter areas 

Field Description 

Business Unit Filter Select either: 

 Show All to display items for all business units 

 a business unit from the drop-down list to display items for the 
selected business unit. 

Item Filter Select either: 

 Show All to display purchase orders for all items 

 an item to display purchase orders that include the selected item. 

Status Select: 

 On Order to display purchase orders that have been authorised but 
not yet filled 

 Partially Filled to display purchase orders that have had some 
items delivers 

 Completed to display purchase orders that have been completed 

 Cancelled to display purchase orders that have been cancelled. 

Also show Purchase 
Orders with no line 
items 

Select to also display purchase orders that have no items entered. 

Purchase Orders grid fields 

Field Description 

Order No. Number for the purchase order. 

Business Unit Business unit that the purchase order is for. 

Supplier Supplier that the purchase order was sent to. 

Date Date of the purchase order. 

Type Type of the purchase order. 

Lines Number of lines on the purchase order. 
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Details grid fields 

Field Description 

Line No. Line number. 

Description Description for the item ordered. 

Item Code Code for the item ordered. 

Supplier Item Code Code used by the supplier for the item ordered, if known. 

Ordered Quantity Quantity of the item ordered. 

Ordered Unit Cost Cost per unit ordered. 

Supplied Quantity Quantity of the item supplied. 

Supplied Unit Cost Cost per unit supplied. 

Status Status of the purchase order. 

Buttons 

Buttons Description 

 
Launch Item Maintenance for the selected grid entry. 

 
Launch Creditor Maintenance for the supplier of the item. 

 
Launch Purchase Order Maintenance for the grid entry. 
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Stock Summary - Sales Analysis tab 

Use the Sales Analysis tab to view detailed information about the sales, pricing and profit per month. 
You can filter the results to show: 

 overall sales at your organisation 

 sales for a particular date range 

 sales for a particular business unit 

 sales for a category of item 

 sales for a particular item 

 sales of consignment or non-consignment stock. 

Opening the Sales Analysis tab 

To open the Sales Analysis tab: 

1. Select Sales > Stock Summary from the Synergetic main menu. 

Tip: You can also access the Sales functions by clicking . 

The Low Stock tab of the Stock Summary window is displayed. 

2. Click Sales Analysis. 

The Sales Analysis tab is displayed. 
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Stock Summary - Sales Analysis tab key fields and buttons 

Filter areas 

Field Description 

Sales By Month 
and... 

Select the criteria that you want to analyse by month. Your selection 
determines which filter areas and grid fields are displayed. 

Show Date Range 
From / To 

Select the first and last dates of the period that you want to analyse sales 
for. 

Tip: To analyse all sales up to the present, deselect the To field. To 
analyse all past sales, deselect the From field. 

Business Unit Filter Select either: 

 Show All to display items for all business units 

 a business unit from the drop-down list to display items for the 
selected business unit. 

Category Filter Select either: 

 Show all to display all item categories 

 an item category from the drop-down list to analyse sales only for 
this category. 

Note: Item categories are listed in the luItemCategory lookup table and 
are set on the Item tab of Item Maintenance. See Item Maintenance - 
Item tab (on page 16). 

Item Filter Select either: 

 Show All to analyse sales for all items 

 an item to analyse sales for the selected item. 

Consignment Filter Select either: 

 Non-Consignment to analyse sales for non-consignment stock only

 Consignment to analyse sales for consignment stock only 

 All to analyse sales for all stock. 

Include Tax in Prices 
and Sales Figures 

Select to include tax amounts in the sales analysis figures. 

Include Non-Stock 
Items (e.g. 
Rounding) 

Select to include non-stock items. 
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Grid fields 

Note: Depending on your filter selections some of the following fields may not be displayed. 
 

Field Description 

Month Month that the sales took place in. 

Item Code Code for the item. 

Item Description Description of the item. 

Category Item category. 

Total Quantity Total quantity of the item sold. 

Total Sales Total price for the quantity of the item sold. 

Total Costs Total cost for the quantity of the item sold. 

Total Profit Total profit made from the sale of the item. 

Average Price Average price that the item was sold for. 

Average Cost Average cost of the item. 

Markup Percentage markup on the item on average. 

Gross Margin Difference between selling price and cost as a percentage of the selling cost.

Buttons 

Button Description 

 
Apply the criteria selected in the Filters area to refresh the results displayed 
in the grid area. 
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Stock Summary - Purchases Analysis tab 

Use the Purchases Analysis tab to view detailed information about purchases per month. You can 
filter the results to show: 

 overall purchases at your organisation 

 purchases for a particular date range 

 purchases for a particular business unit 

 purchases for a category of item 

 purchases for a particular item 

Opening the Purchases Analysis tab 

To open the Purchases Analysis tab: 

1. Select Sales > Stock Summary from the Synergetic main menu. 

Tip: You can also access the Sales functions by clicking . 

The Low Stock tab of the Stock Summary window is displayed. 

2. Click Purchases Analysis. 

The Purchases Analysis tab is displayed. 
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Stock Summary - Purchases Analysis tab key fields and buttons 

Filter areas 

Field Description 

Purchases By Month 
and... 

Select the criteria that you want to analyse the purchases by month for. Your 
selection determines which filter areas are displayed. 

Show Date Range 
From / To 

Select the first and last dates of the period that you want to analyse sales 
for. 

Tip: To analyse all sales up to the present, deselect the To field. To 
analyse all past sales, deselect the From field. 

Business Unit Filter Select either: 

 Show All to display items for all business units 

 a business unit from the drop-down list to display items for the 
selected business unit. 

Category Filter Select either: 

 Show all to display all item categories 

 an item category from the drop-down list to analyse sales only for 
this category. 

Note: Item categories are listed in the luItemCategory lookup table and 
are set on the Item tab of Item Maintenance. See Item Maintenance - 
Item tab (on page 16). 

Item Filter Select either: 

 Show All to analyse sales for all items 

 an item to analyse sales for the selected item. 
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Grid fields 

Note: Depending on your filter selections some of the following fields may not be displayed. 
 

Field Description 

Month Month that the purchases took place in. 

Item Code Code for the item. 

Item Description Description of the item. 

Category Item category. 

Total Qty Ordered Total quantity of the item ordered. 

Total Cost Ordered Total cost for the quantity of the item ordered. 

Total Qty Supplied Total quantity of the item supplied. 

Total Cost Supplied Total cost of the items supplied. 

Buttons 

Button Description 

 
Apply the criteria selected in the Filters area to refresh the results displayed 
in the grid area. 
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Making consignment stock payments 
Consignment stock are stock items that are: 

 owned by a third party, such as a parent selling their second-hand books or uniforms 

 sold by your organisation in return for a commission. 

On a periodic basis, you process payments to the creditors (for example, parents) for goods sold on 
their behalf. 

What you can do: 

What you can do… See… 

Maintain the: 

 business unit you are 
processing commission 
payments for 

 percentage commission being 
received for selling consignment 
stock 

 general ledger codes and tax 
codes used. 

Consignment Stock Payments - Selections window (on 
page 161) 

Maintain: 

 whether debtors are processed 

 the fee codes used with debtors. 

Consignment Stock Payments - Debtors window (on page 
164) 

Maintain the level of detail to report to the 
creditor. 

Consignment Stock Payments - Creditors window (on 
page 166) 

Maintain the: 

 posting details 

 bank account to process 
payments and receipts against. 

Consignment Stock Payments - Post window (on page 
168) 
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Consignment Stock Payments - Selections window 

Use the Consignment Stock Payments - Selections window to select the: 

 business unit you are processing commission payments for 

 percentage commission being received for selling consignment stock 

 minimum payment amount 

 general ledger codes and tax codes used. 

Opening the Consignment Stock Payments - Selections window 

To open the Selections window: 

1. Select Module > Sales > Consignment Stock Payments from the main menu. 

The Consignment Stock Payments - Selections window is displayed. 

 

2. Type in your selections. 

3. Click . 

The Consignment Stock Payments - Debtors window is displayed. See Consignment Stock 
Payments - Debtors window (on page 164). 

Tip: You can navigate between the windows using  and . 
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Consignment Stock Payments - Selections window – key fields 

Field Description 

Business Unit Business unit at your organisation that consignment payments are being 
processed for. 

Min Payment to 
Supplier 

If the amount due to the creditor is less than the Min Payment to Supplier, 
no payment is made and the amount owing is carried forward to the next 
consignment stock payment run. 

Commission Percent Percentage commission received by your organisation for selling the 
consignment goods on behalf of creditors, such as parents. 

The commission for consignment stock includes GST, in Australia and New 
Zealand. For example, a 10% commission on a $100 sale results in: 

 $9.00 commission and $1.00 GST in Australia 

 $8.50 commission and $1.50 GST in New Zealand. 

Commission G/L 
Code 

General ledger code to allocate the commission paid to the organisation. 

Commission Tax 
Code 

Tax code used for tax treatment. 

Purchases G/L Code General ledger code to allocate the amount paid to creditors. 
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How the G/L codes work for consignment stock 

The commission for consignment stock includes GST, in Australia and New Zealand. 

For example, a 25% commission on a $100 sale in Australia results in: 

 $25 commission divided between: 

– $2.27 credited to the GST G/L account (10% GST) 

– $22.73 credited to the Commission G/L account (net of GST). 

 $75.00 credited to the Creditors control account. 

 

In New Zealand, the same example results in: 

 $25 commission divided between: 

– $3.26 credited to the GST G/L account (15% GST) 

– $21.74 credited to the Commission G/L account (net of GST). 

 $75.00 credited to the Creditors control account. 
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Consignment Stock Payments - Debtors window 

Consignment payments can be credited to the stock owner's debtor account. 

Use the Consignment Stock Payments - Debtors window to specify whether to process debtors and 
which fee code to use. 

Opening the Consignment Stock Payments - Debtors window 

To open the Debtors window: 

1. First, make your selections in the Consignment Stock Payments - Selections window. See 
Consignment Stock Payments - Selections window (on page 161). 

The Consignment Stock Payments - Selections window is displayed. 

2. Click . 

The Consignment Stock Payments - Debtors window is displayed. 

 

3. Type in your selections. 

4. Click . 

The Consignment Stock Payments - Creditors window is displayed. See Consignment Stock 
Payments - Creditors window (on page 166). 

Tip: You can click  to edit the Consignment Stock Payments - Selections window. 
See Consignment Stock Payments - Selections window (on page 161). 
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Consignment Stock Payments - Debtors window - key fields 

Field Description 

Process Debtors Select to process debtors. 

Allow Debtors to go 
into Credit 

Select the field to allow debtors to go into credit. This credit will subsequently 
be taken up by the debtor at a later date. For example, a parent (debtor) 
might be selling a second-hand uniform on consignment. Any money from 
the sale can be credited to the debtor's account which might already be fully 
paid up. When the debtor next receives a bill for their tuition fees, the credit 
is netted off the total owed. 

Clear the field to prevent the debtor from going into credit. If you are paying 
for consignment stock through the debtors system, and the debtor’s 
outstanding balance is less than the amount you are paying, a cheque is 
issued for the difference. For example, if the debtor’s balance is $50 and the 
consignment payment is $150, $50 is allocated to the debtor account and a 
cheque is issued for $100. 

Fee Code Fee code to be used for the payments to creditors. 
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Consignment Stock Payments - Creditors window 

Use the Consignment Stock Payments - Creditors window to specify the level of detail to report to 
the creditor on remittance advice. 

Opening the Consignment Stock Payments - Creditors window 

To open the Creditors window: 

1. First, make your selections in the following windows: 

 Consignment Stock Payments - Selections window (on page 161). 

 Consignment Stock Payments - Debtors window (on page 164). 

2. Click . 

The Consignment Stock Payments - Creditors window is displayed. 

 

3. Type in your selections. 

4. Click . 

The Consignment Stock Payments - Post window is displayed. See Consignment Stock 
Payments - Post window (on page 168). 

Tip: You can click  to edit the Consignment Stock Payments - Debtors window. 
See Consignment Stock Payments - Debtors window (on page 164). 
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Consignment Stock Payments - Creditors window key fields 

Field Description 

R/A Style Select one of the remittance advice (R/A) styles, depending on whether you 
want:  

 detailed, to list individual items 

 summary, to show a single payment amount 

 commission included, to only show net payment amounts 

 separate commission line, to show the commission as a negative 
amount in a separate line. 

Summary Line 
Description 

Description to appear in the summary line, depending on the style. 

Commission Line 
Description 

Description to appear in the commission line, depending on the style. 
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Consignment Stock Payments - Post window 

Use the Consignment Stock Payments - Post window to specify the: 

 posting details 

 bank account to process payments against. 

Opening the Consignment Stock Payments - Post window 

To open the Post window: 

1. First, make your selections in the following windows: 

 Consignment Stock Payments - Selections window (on page 161). 

 Consignment Stock Payments - Debtors window (on page 164). 

 Consignment Stock Payments - Creditors window (on page 166). 

2. Click . 

The Consignment Stock Payments - Post window is displayed. 

 

3. Type in your selections. 

4. Click . 

Any outstanding consignment payments are processed. 

Tip: You can click  to edit the Consignment Stock Payments - Creditors window. 
See Consignment Stock Payments - Creditors window (on page 166). 
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Consignment Stock Payments – Post window key fields 

Field Description 

Posting Date Date the postings appear in the general ledger. 

Description Description for the sales close off postings. 

Bank Account Bank account used to make consignment stock payments from. 

Printing creditor cheques 

Once you have run the consignment stock payment process, you can print creditor cheques. See 
Printing creditor cheques in the Creditors manual. 

Note: If Synergetic is configured to produce detailed reports, it will produce multiple invoices for 
the creditor. However, only one cheque is printed for all the items that appear on the remittance 
advice. 
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Stocktaking items 
When performing a stocktake, the stock on hand is physically counted and the stock count figures 
entered into Synergetic. This ensures that the stock on hand figures are correct. 

See Introduction to stocktaking (on page 172). 

One method of performing the stocktake is for: 

 one person to use a wireless barcode scanner to scan the stock item and count the stock 

 another person to enter the count called out by the first person. 

Another method is use a laptop with a: 

 wireless connection to your network 

 barcode scanner attached to the laptop. 

If your laptop does not have a wireless connection to your network, you can perform the stocktake by 
creating a merge file using a: 

 laptop without a wireless connection 

 barcode scanner attached to the laptop. 

Note: Take care to ensure that the laptop is always on a stable surface and avoid holding it by the 
screen, as hinges can become damaged in some models. 

How to: 

 Record the stocktake on a report then type the values into Synergetic. See Stocktaking using 
the Item Stocktake report (on page 186). 

 Scan a representative item's barcode or enter the item code, then enter the quantity of that 
item into Synergetic. See Stocktaking using a representative item (on page 190). 

 Scan the barcode of each individual item in turn, with Synergetic incrementing the count 
automatically. See Stocktaking using the barcode of individual items (on page 194). 

 Create a text file of the stocktake and merge the file into Synergetic. See Stocktaking using a 
merge file (on page 198). 

 Reprint Item Stocktake reports. See Reprinting Item Stocktake reports (on page 211).  

 Create a stocktake for another business unit. See Creating a stocktake for another business 
unit (on page 217). 

 Update whether to include consignment stock in the stocktake or not. See Synergetic 
Financial Configuration - Business Units - Consignment sub-tab in the Finance manual. 

 Restore a closed stocktake to modify or abandon it. See Restoring a closed off stocktake (on 
page 220). 
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What you can do 

What you can do… See… 

You can: 

 record the stocktake on a report then type 
the values into Synergetic 

 scan a representative item's barcode or 
enter the item code, then enter the quantity 
of that item into Synergetic  

 scan the barcode of each individual item in 
turn, with Synergetic incrementing the count 
automatically 

 load a text file of item barcodes and counts 
into Synergetic 

 confirm the figures are correct and close off 
the stocktake for the selected business unit 
and date. 

Using the Item Stocktake window (on page 
176) 
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Introduction to stocktaking 

When to perform a stocktake 

This task is usually performed annually at the close of the financial year but can be done more 
frequently according to the policy at your organisation.  

Preferably plan your stocktake for a time when there are no sales or other activities that will affect the 
stocktaking process. During sales entry, you can tell when a stocktake is being performed because the 
business unit is highlighted in red. 

 

If Synergetic is configured to prevent sales being performed during a stocktake, the following message 
is displayed: 

 

However, Synergetic can be set to allow you to sell stock during a stocktake. To do this, select the 
Allow sales when Stocktake in progress field on the Sales sub-tab of Finance Configuration 
Maintenance. See Synergetic Financial Configuration - Business Units - Sales sub-tab in the Finance 
manual. 
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Item Stocktake report 

The Item Stocktake report is an integral part of stocktaking for many organisations. The Item 
Stocktake report is printed when a stocktake is initiated, and is typically used to record the stock on 
hand of each stock item. The person stocktaking writes the actual stock on hand in the Count column 
next to the item. 

 

You can reprint the Item Stocktake report from the Item Stocktake window. See Reprinting Item 
Stocktake reports (on page 211). 

To more quickly record the count on the Item Stocktake window, scan the barcode on the Item 
Stocktake report then type the count written earlier. See Stocktaking using the Item Stocktake report 
(on page 186). 



Sales Managing stock 

Page 17-174 Version 65.19 

 

The effect of stocktake adjustments on item receipts 

When you perform a stocktake, an adjustment may be required to set an item's stock on hand to the 
quantity that was counted. 

In this example, the book Windows Interface Guidelines needs adjusting from the S.O.H. 
(Synergetic's stock on hand) figure of 2 to the Count of 3. 

 

When you close off the stocktake for the business unit, a stock adjustment of 1 is created in 
Synergetic as an item receipt. 

 

The adjustment details are also included on the Item Stocktake report, as shown below.  
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If you navigate to the Receipts tab of Item Maintenance, the corresponding receipt can be easily 
identified as any receipts generated from a stocktake are italicised. In this case, the receipt was for a 
quantity received of 1, with no unit cost or creditor applicable. 
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Using the Item Stocktake window 

Use the Item Stocktake window to: 

 Record the stocktake on a report then type the values into Synergetic. See Stocktaking using 
the Item Stocktake report (on page 186). 

 Scan a representative item's barcode or enter the item's code, then enter the quantity of that 
item into Synergetic. See Stocktaking using a representative item (on page 190). 

 Scan the barcode of each individual item in turn, with Synergetic incrementing the count 
automatically. See Stocktaking using the barcode of individual items (on page 194). 

 Merge a text file of item barcodes and counts into the stocktake. See Stocktaking using a 
merge file (on page 198). 

 Delete items from the stocktake. 

 Abandon the stocktake. 

 Confirm the figures are correct and close off the stocktake for the selected business unit and 
date. 

Opening the Item Stocktake window 

To open the Item Stocktake window: 

1. Select Module > Sales > Item Stocktake. 

If there are no open stocktakes, the Create New Stocktake window is displayed. Otherwise, the 
Item Stocktake window is displayed - skip to step 7. 

 

2. Select the Business Unit to perform the stocktake for, if it is different to that displayed. 

3. Change the Process Date if the effective date of the stocktake is different to today's date. 

Note: You can reprint an existing Item Stocktake report at this stage. See Reprinting Item 
Stocktake reports (on page 211). 

4. Click . 

The following dialog is displayed. 
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5. Click . 

The Item Stocktake report is displayed. 

 

6. Print the report, if required. 

7. Click  to close the Item Stocktake report window. 

The Item Stocktake window is displayed. 
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Additional features of the Item Stocktake window - double clicking on the Count field 

Most of the features of Item Stocktake window are described in the key fields and buttons section 
below.  

You can also double click on the Count field, if the actual stock on hand is either: 

 The same as the S.O.H. figure shown. For example, 12 school bags are on hand so you can 
double click on the Count field to accept the S.O.H. figure. 

 Zero. For example, the S.O.H. figure for HTML Black Book is shown as -1 but the stocktake 
confirms that there are none to hand. In this instance, double clicking the Count field enters a 
zero quantity. This also applies if the S.O.H. figure is zero or negative. 

 

Additional features of the Item Stocktake window - sorting columns 

You can sort any of the columns on the Item Stocktake window by clicking on the relevant column 
heading. When the window is opened initially the records are automatically ordered according to their 
Category, Lookup and Code values. In the example below, the Description heading has been 
clicked to sort all of the records in ascending order ( ) based on the description of the items.  

 

Clicking on the Description heading again sorts records in descending order ( ) based on the 
description of the items. 
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Item Stocktake window - key fields and buttons 

Fields 

Field Description 

Locate Field for either: 

 accepting the barcode when scanning an item's barcode 

 typing the item's code. 

Mode Stocktaking mode used for the current stock count entry or entries. Select 
either: 

 Go to Item for manual stock entry 

 Increment Count by 1. 

Use the Go to Item for manual stock entry mode to: 

 Enter the values from the Item Stocktake report. See Stocktaking 
using the Item Stocktake report (on page 186). 

 Enter the values after scanning a representative item's barcode. See 
Stocktaking using a representative item (on page 190). 

Use the Increment Count by 1 mode to scan each individual stock item's 
barcode in turn. See Stocktaking using the barcode of individual items (on 
page 194). 

Grid area fields 

Field Description 

Code Unique code for the item. 

Note: It is recommended that you develop naming standards for item 
codes and descriptions. 

Category Group used to categorise this item. 

For example, Uniform or Books can be set up as categories to group 
similar items together. 

Description Description for the item. 
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Field Description 

S.O.H. Stock on hand. 

The stock on hand figure is Synergetic's calculated value for the item: 

 since the last stocktake figure 

 adding purchase receipts or manual receipts 

 taking off sales made to customers 

 taking off "own use" sales (that is, general ledger sales). 

The stock on hand can be different to the physical count for a variety of 
reasons: 

 the previous stocktake figure was incorrect 

 purchases were not received in correctly or fully before the 
stocktake 

 sales were not booked out correctly or fully before the stocktake 

 "own use" sales were not put through correctly or fully before the 
stocktake 

 barcode labels were stuck onto the incorrect items 

 the wrong items were counted 

 shrinkage. 

Count Physical count of the stock item. 

Adjust Adjustment figure applied when the stocktake is closed. 

Depending on your organisation's stocktaking policy, recount any items 
where the Adjust value for an item is not zero. A second count will confirm 
whether the first count was correct or not. If it confirms that the stock count is 
correct, an adjustment will bring the stock on hand back to its correct level. 

Note: Any adjustment general ledger journals need to be created 
separately. 

Avg Cost Calculated average cost of the stock item. 

Barcode Used for barcoding applications involving stock items. 

If blank, a barcode is not used for this item. 

For example, books that are stocked and sold at your organisation can be 
integrated with POS equipment, using barcodes to speed up the sales entry 
process. 

Lookup Determines the order that items are listed in the search grid. 

Defaults to the value of the Description field but can be changed. For 
example, the item code can serve as a better lookup. 
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Buttons 

Button Description 

 
If the item code or barcode is populated in the Locate field, Synergetic 
locates the item, selects the row and either: 

 positions the cursor in the Count field, if the Go to Item for 
manual stock entry mode is selected 

 increments the Count field, if the Increment Count by 1 mode 
is selected. 

When scanning barcodes, Synergetic automatically populates the 

Locate field and selects  to perform the action specified above. 

 
Launch into Item Maintenance for the selected item.  

See Maintaining items (on page 5). 

 
Either: 

 Select a different open stocktake using the Select Process 
Number window. For example, select the stocktake for a 
different business unit at your organisation. 

 

 Click  to create a new stocktake. For example, 
create a stocktake for another business unit. See Creating a 
stocktake for another business unit (on page 217). 
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Button Description 

 
To print the Item Stocktake report: 

1. Click . 

The Print Stocktake window is displayed. 

 

2. Select either: 

 Initial Printout 

 Preview / Close Off Printout. 

3. Click . 

The Item Stocktake report is previewed. 
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Button Description 

 
Abandon the stocktake before it is closed off and delete all records associated 
with the current stocktake. 

To abandon a stocktake: 

1. Click . 

The following window is displayed.  

 

2. Type abandon. 

Note: This field is not case sensitive. 

3. Click . 

The following window is displayed.  
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Button Description 

 
Remove the selected item from the stocktake, if the policy at your organisation 
permits these items to be removed. 

For example, a stocktake may not be required for a discontinued item. 

 

Note: If an item is not in stock, enter a zero value in the Count field. 

Alternatively, enter the count of the stock, even if it is zero, and make the stock 
inactive before the next stocktake. 

 
Open the Load Merge File window to merge a text file of item barcodes and 
counts into Synergetic. See Stocktaking using a merge file (on page 198). 
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Button Description 

 
Confirm the figures entered are correct and close off the stocktake for the 
business unit and date specified. 

To close off the stocktake: 

1. Click  

The following dialog window is displayed. 

2. Click . 

The Item Stocktake report is printed and the following message is 
displayed.  

 

If a count has not been entered for all items, you can: 

 stocktake and enter a count for the remaining items 

 enter a zero count for items that are not in stock 

 delete the items from the stock count, if the policy at your organisation 
permits these items to be removed. 
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Stocktaking using the Item Stocktake report 

To record the stocktake using the Item Stocktake report: 

1. Select Module > Sales > Item Stocktake. 

If there are no open stocktakes, the Create New Stocktake window is displayed. Otherwise, the 
Item Stocktake window is displayed - skip to step 8. 

 

2. Select the Business Unit to perform the stocktake for, if it is different to that displayed. 

3. Change the Process Date if the effective date of the stocktake is different to today's date. 

Note: You can reprint an existing Item Stocktake report at this stage. See Reprinting Item 
Stocktake reports (on page 211). 

4. Click . 

The following dialog is displayed. 
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5. Click . 

The Item Stocktake report is displayed. 

 

6. Print the report. 

7. Click  to close the Item Stocktake report window. 

The Item Stocktake window is displayed. 

 

8. Select an item on the report to stocktake. 

9. Physically count the stock. 

10. Write the count on the report. 

11. Repeat steps 8 through 10 for each item. 
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12. For each item listed on the report, type the stock count number into the corresponding Count 
fields on the Item Stocktake window. 

 

13. Depending on your organisation's stocktaking policy, recount any items where the count is 
different to the S.O.H. field. That is, where the Adjust value for an item is not zero. 

Note: Stock adjustments are not created until the stocktake is closed off. 

14. Click  when the stocktake is complete. 

The following dialog window is displayed. 
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15. Click . 

The Item Stocktake report is printed to your default printer and the following message is 
displayed.  

 

16. Click . 

The Item Stocktake window is closed. 

17. Create any adjustment G/L journals you require. See Entering general ledger journals in the 
General ledger manual. 

For example, depending on how your organisation manages inventory you can: 

 create a G/L journal from the stock control (balance sheet) account to the stock movement 
(profit and loss) account 

 optionally also do a secondary G/L journal to a stock write off account. 
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Stocktaking using a representative item 

You can use representative items to enter a stocktake. That is: 

 Scan an item on the shelf or enter its item code. This is the representative item. 

 Count how many there are, including the one that was just scanned. 

 Enter the count using the Item Stocktake window. See Using the Item Stocktake window (on 
page 176). 

Alternatively, for some items it is easier to use the Increment Count by 1 mode. See Stocktaking 
using the barcode of individual items (on page 194). 

One method of performing the stocktake is for: 

 one person to use a wireless barcode scanner to scan the stock item and count the stock 

 another person to enter the count called out by the first person. 

Another method is use a laptop with a: 

 wireless connection to your network 

 barcode scanner attached to the laptop. 

To record the stocktake by using representative items: 

1. Select Module > Sales > Item Stocktake. 

If there are no open stocktakes, the Create New Stocktake window is displayed. Otherwise, the 
Item Stocktake window is displayed - skip to step 7. 

 

2. Select the Business Unit to perform the stocktake for, if it is different to that displayed. 

3. Change the Process Date if the effective date of the stocktake is different to today's date. 

Note: You can reprint an existing Item Stocktake report at this stage. See Reprinting Item 
Stocktake reports (on page 211). 

4. Click . 

The following dialog is displayed. 
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5. Click . 

The Item Stocktake report is displayed. 

 

6. Click  to close the Item Stocktake report window. 

The Item Stocktake window is displayed. 

7. Select the Go to Item for manual stock entry mode, if not already selected. 
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8. Either: 

 Scan the barcode of a representative stock item. For example, if you have several reams of 
A4 paper scan the barcode on one of the reams. 

 Enter the item code of a representative stock item in the Locate field and click . 

The cursor is positioned in the Count field of the item. 

 

9. Physically count the number of the selected stock item. 

10. Type the stock count value. 

11. Press Enter or select the Locate field. 

The stock count is recorded and the Item Stocktake window is prepared for the next item to be 
scanned or entered. 

 

12. Repeat steps 8 through 10 for each item. 
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13. Depending on your organisation's stocktaking policy, recount any items where the count is 
different to the S.O.H. field. That is, where the Adjust value for an item is not zero. 

Note: Stock adjustments are not created until the stocktake is closed off. 

14. Click  when the stocktake is complete. 

The following dialog window is displayed. 

 

15. Click . 

The Item Stocktake report is printed to your default printer and the following message is 
displayed.  

 

16. Click . 

The Item Stocktake window is closed. 

17. Create any adjustment G/L journals you require. See Entering general ledger journals in the 
General ledger manual. 

For example, depending on how your organisation manages inventory you can: 

 create a G/L journal from the stock control (balance sheet) account to the stock movement 
(profit and loss) account 

 optionally also do a secondary G/L journal to a stock write off account. 
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Stocktaking using the barcode of individual items 

You can scan the barcode of each individual item in turn, with Synergetic incrementing the count 
automatically.  

Alternatively, for some items it is easier to use the Go to Item for manual stock entry mode. See 
Stocktaking using a representative item (on page 190). 

To scan barcodes, you can use either a: 

 wireless barcode scanner 

 barcode scanner attached to a laptop with a wireless connection to your network. 

To record the stocktake by scanning the barcodes of individual stock items: 

1. Select Module > Sales > Item Stocktake. 

If there are no open stocktakes, the Create New Stocktake window is displayed. Otherwise, the 
Item Stocktake window is displayed - skip to step 7. 

 

2. Select the Business Unit to perform the stocktake for, if it is different to that displayed. 

3. Change the Process Date if the effective date of the stocktake is different to today's date. 

Note: You can reprint an existing Item Stocktake report at this stage. See Reprinting Item 
Stocktake reports (on page 211). 

4. Click . 

The following dialog is displayed. 
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5. Click . 

The Item Stocktake report is displayed. 

 

6. Click  to close the Item Stocktake report window. 

The Item Stocktake window is displayed. 

7. Select the Increment Count by 1 mode.  
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8. Scan the barcode of an individual stock item. 

The count is incremented by one for the selected item. 

 

9. Repeat step 8 until there is no more stock that needs counting. 

Note: It does not matter which order items are scanned, as each individual item is identified by its 
barcode. 

 

10. Depending on your organisation's stocktaking policy, recount any items where the count is 
different to the S.O.H. field. That is, where the Adjust value for an item is not zero. 

Note: Stock adjustments are not created until the stocktake is closed off. 

11. Click  when the stocktake is complete. 

The following dialog window is displayed. 
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12. Click . 

The Item Stocktake report is printed to your default printer and the following message is 
displayed.  

 

13. Click . 

The Item Stocktake window is closed. 

14. Create any adjustment G/L journals you require. See Entering general ledger journals in the 
General ledger manual. 

For example, depending on how your organisation manages inventory you can: 

 create a G/L journal from the stock control (balance sheet) account to the stock movement 
(profit and loss) account 

 optionally also do a secondary G/L journal to a stock write off account. 
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Stocktaking using a merge file 

You can load a text file of barcodes and item counts into Synergetic's stocktake. This is useful for a 
warehouse that does not have easy network access: you can create the text file offline and load it into 
Synergetic at a later point. 

How to: 

 Create a merge file. See Creating a merge file (on page 199). 

 Load a merge file into Synergetic. See Loading a merge file into Synergetic (on page 206). 
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Creating a merge file 

A merge file is a text file that contains the barcodes of all items to be included in the stocktake and 
their stock count. Each line in the text file has an item barcode and the item's stock count separated by 
a delimiter character. 

Note: A delimiter character is a special character that does not appear in the file's information. It 
is used to separate information so that Synergetic can tell where one piece of information ends 
and the next piece begins. The standard delimiter character is a comma. 

 

A merge file can begin with a Header Row; a row that indicates the order of the information on each 
line.  

 

 If it does not, the information must be ordered according to the Stocktake Import Rules. 
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Opening the Stocktake Import Rules 

To open the Stocktake Import Rules window: 

1. Select Module > Sales > Item Stocktake. 

If there are no open stocktakes, the Create New Stocktake window is displayed. Otherwise, the 
Item Stocktake window is displayed - skip to step 7. 

 

2. Select the Business Unit to perform the stocktake for, if it is different to that displayed. 

3. Change the Process Date if the effective date of the stocktake is different to today's date. 

Note: You can reprint an existing Item Stocktake report at this stage. See Reprinting Item 
Stocktake reports (on page 211). 

4. Click . 

The following dialog is displayed. 
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5. Click . 

The Item Stocktake report is displayed. 

 

6. Click  to close the Item Stocktake report window. 

The Item Stocktake window is displayed. 

7. Click . 

The Load Merge File window is displayed 

 



Sales Managing stock 

Page 17-202 Version 65.19 

 

8. Click . 

The Import Rules window is displayed. 
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Creating a merge file 

You can create a merge file: 

 with any word processing application such as Microsoft Word, Notepad or WordPad 

 with Microsoft Excel. 

 For larger merge files, it is usually more efficient to use Microsoft Excel. Microsoft Excel allows you to 
sort information, which makes finding duplicate barcodes much easier. 

Creating a merge file with a word processor 

To create a merge file using a word processor such as Notepad: 

1. Open the word processing application and create a new file. 

2. If you are using a Header Row, type the name of each header, followed by a comma. Do not put a 
full stop at the end.  

 

3. Press Enter to go to the next line. 

4. Type the item's barcode. 

Note: If you have used a Header Row, enter the information in the same order as the Header 
Row. 

5. Press the comma key. 

6. Type the count of the item. Do not put a comma or full stop at the end of the line. 

Note: Do not use a thousands separator. The number "twelve thousand and forty-seven" must be 
written as 12047 not 12,047.  

7. Repeat steps 3 through 6 until no more items are to be counted. 

8. Combine any duplicate barcodes into one entry by adding their counts together. 

9. Remove any blank lines. 

10. Save the file as a text file (that is, with a suffix of .txt).  

Note: If you are using Microsoft Word, you need to select this from the Save As Type: drop-down 
list. 

11. Exit the word processor. 
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Creating a merge file with Microsoft Excel 

To create a merge file using Microsoft Excel: 

1. Open Microsoft Excel and create a new file. 

2. If you are using a Header Row, type each header into its own cell in the first row. 

 

3. Go to the start of the next row. 

4. Type the item's barcode. 

Note: If you have used a Header Row, enter the information in the same columns as the headers. 

5. Go to the next column. 



Managing stock Sales 

Version 65.19 Page 17-205 

 

6. Type the item's count. 

Note: If numbers higher than 999 are appearing with a comma, highlight the affected column and 
click Format > Cells.... Make sure the Category is set to Number and the Use 1000 Separator 
(,) field is cleared. 

 

7. Repeat steps 3 through 6 until all there are no more items to be counted. 

8. Click Data > Sort. 

9. If you have used a Header Row, select Sort By: Barcode. If you have not used a Header Row, 
select Sort By: Column A. 

10. Combine any duplicate barcodes into one entry by adding their counts together. 

11. Repeat steps 8 through 9 to remove any blank lines. 

12. Click File > Save As.... 

13. Enter a file name. 

14. Select Save As Type: CSV (Comma Separated Value). 

15. Click Save. 

16. Exit Microsoft Excel. 
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Loading a merge file into Synergetic 

You can load a merge file containing the barcode and number of each item into Synergetic, instead of 
stocktaking with Synergetic directly. You will need a prepared merge file. See Creating a merge file 
(on page 199). 

To load a merge file: 

1. Select Module > Sales > Item Stocktake. 

If there are no open stocktakes, the Create New Stocktake window is displayed. Otherwise the 
Item Stocktake window is displayed - skip to step 7. 

 

2. Select the Business Unit to perform the stocktake for, if it is different to that displayed. 

3. Change the Process Date if the effective date of the stocktake is different to today's date. 

Note: You can reprint an existing Item Stocktake report at this stage. See Reprinting Item 
Stocktake reports (on page 211). 

4. Click . 

The following dialog is displayed. 
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5. Click . 

The Item Stocktake report is displayed. 

 

6. Click  to close the Item Stocktake report window.  

The Item Stocktake window is displayed. 
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7. Click . 

The Load Merge File window is displayed. 

 

8. Click . 

The Import File window is displayed. 

9. Select your merge file and click . 

10. Check that the Delimiter Character is the one used in your merge file.  

Note: A Delimiter Character is the character used to separate pieces of information. For 
example, your merge file has an item's barcode followed by a delimiter character and then the 
number of items on hand. The standard delimiter character is a comma. 

11. If your merge file starts with a row that displays the order of the information, select File Contains 
Header Record. 
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12. Click . 

The merge file is loaded into Synergetic. Synergetic matches the listed barcodes to item barcodes, 
and then to item codes if no barcodes match. If the merge file contains barcodes that do not match 
any stock in Synergetic, the Stocktake Import: Invalid Barcodes window appears listing the 
invalid barcodes. 

 

Note: Unless there are many invalid barcodes, it is usually best to note down the invalid codes, 

and click  to continue the import. Those items can be entered later by creating another 
merge file with the correct barcodes, or entering stocktake item counts directly into Synergetic. 
See Stocktaking using the Item Stocktake report (on page 186), Stocktaking using a 
representative item (on page 190), and Stocktaking using the barcode of individual items (on page 
194). 

The Stocktake Import: Existing Items window is displayed. 
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13. Select how you want Synergetic to use the import file. Synergetic can: 

 ignore any items that are not listed in the merge file (Ignore Count)  

 set the item count to zero for any item not listed in the merge file (Set Count to Zero)  

 add the merge file item counts to the stocktake item counts (Increment Count by Value in 
File) 

 overwrite the stocktake figures, by setting all item counts to the value in the merge file (Set 
Count to Value in File). 

Note: Usually, you would select Ignore Count and Increment Count by Value In File if you are 
using the merge file to add to your stocktake, and Set Count to Zero and Set Count to Value In 
File if you are managing your whole stocktake with this merge file. 

14. Click . 

The stocktake counts are updated. 
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Reprinting Item Stocktake reports 

The method of reprinting Item Stocktake reports depends on whether there is: 

 an open stocktake and you want to reprint the initial Item Stocktake report for this stocktake 

 an open stocktake and you want to reprint either the initial or close off report for a prior 
stocktake 

 no open stocktake and you want to reprint either the initial or close off report for a prior 
stocktake. 

Reprinting an Item Stocktake report for the current stocktake 

You can reprint the initial Item Stocktake report at any time before the stocktake is closed off. 

To reprint the initial Item Stocktake report of the current stocktake: 

1. Select Module > Sales > Item Stocktake. 

The Item Stocktake window is displayed. 

 

2. Click . 

The Print Stocktake window is displayed. 
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3. Select either: 

 Initial Printout 

 Preview / Close Off Printout. 

4. Click . 

The Item Stocktake report is previewed. 

 

5. Print the report. 
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Reprinting a prior Item Stocktake report when a stocktake is open 

To reprint the initial or close off Item Stocktake report of a prior stocktake and you are working on the 
latest stocktake: 

1. Select Module > Sales > Item Stocktake. 

The Item Stocktake window is displayed. 

 

2. Click . 

The Select Process Number window is displayed.  

 

3. Locate and select the stocktake process to reprint. 
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4. Click . 

The Print Stocktake window is displayed. 

 

5. Select either: 

 Initial Printout 

 Preview / Close Off Printout. 

6. Click . 

The Item Stocktake report is previewed. 

 

7. Print the report. 
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Reprinting a prior Item Stocktake report when there is no open stocktake 

To reprint the initial or close off Item Stocktake report of a prior stocktake and there is no open 
stocktake: 

1. Select Module > Sales > Item Stocktake. 

The Create New Stocktake window is displayed. 

 

2. Click . 

The Select Process Number window is displayed.  

 

3. Locate and select the stocktake process to reprint. 

4. Click . 

The Print Stocktake window is displayed. 
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5. Select either: 

 Initial Printout 

 Preview / Close Off Printout. 

6. Click . 

The Item Stocktake report is previewed. 

 

7. Print the report. 
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Creating a stocktake for another business unit 

Some organisations may need to stocktake each business unit at the same time. This requires the 
creation of stocktakes for each additional business unit. 

Alternatively, you can stocktake and close off each business unit in turn. See: 

 Stocktaking using the Item Stocktake report (on page 186) 

 Stocktaking using a representative item (on page 190) 

 Stocktaking using the barcode of individual items (on page 194). 

Note: You cannot perform more than one stocktake for the same business unit at the same time. 

To create stocktakes for additional business units: 

1. Select Module > Sales > Item Stocktake. 

The Item Stocktake window is displayed for the first business unit. For example, the College 
business unit. 

 

2. Click . 

The Select Process Number window is displayed.  
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3. Click . 

The Create New Stocktake window is displayed. 

 

4. Select the Business Unit to perform the stocktake for. In this example, select the Bookshop 
business unit. 

 

5. Change the Process Date if the effective date of the stocktake is different to today's date. 

6. Click . 

The following dialog is displayed. 
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7. Click . 

The Item Stocktake report is displayed.  

 

8. Click  to close the Item Stocktake report window. 

The Item Stocktake window is displayed for the selected business unit. 

 

9. Stocktake the items for the business unit, as per normal. See Using the Item Stocktake window 
(on page 176). 

10. Repeat from step 2 for each additional business unit. 
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Restoring a closed off stocktake 

You can restore a closed off stocktake if you want to: 

 change which items are included 

 change the stock counts of the items 

 abandon the stocktake. 

To restore a closed off stocktake: 

1. Select Module > Sales > Item Stocktake. 

The Create New Stocktake window is displayed. 

 

Note: If you have open stocktakes, the Item Stocktake window is displayed instead. Click 

 to display the Select Process Number window, and then click . 
The Create New Stocktake window is displayed. 

2. Click . 

The Select Process Number window is displayed. 

 

3. Select the closed off stocktake you want to restore. 
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4. Click . 

A confirmation window is displayed. 

 

5. Click . 

The stock adjustments from the stocktake are deleted, and the Item Stocktake window is 
displayed with the stocktake. 
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Key sales reports 
There are a number of standard reports available to you to help you manage your sales. See the 
folder of Crystal Reports supplied to your organisation. 

To access these reports, select Module > Sales > Sales Crystal Reports Available. You can browse 
or search through reports: 

 previously marked as 'favourites' 

 from a specific module 

 from all modules. 

You can search for reports based on the report: 

 description 

 code. 

See Running reports in the Introduction manual for general information on how to run reports in 
Synergetic. 
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Description of key reports 

Report Description 

Sales Docket Crystal Report output at the end of a sale, if configured at your organisation. This 
report may have been tailored for your needs. 

 

Alternatively, your organisation may print the Sales Docket directly to the printer 
port.  

 



Key sales reports Sales 

Version 65.19 Page 17-225 

Report Description 

Consignment 
Stock Items 

Report on sales of consignment stock items by business unit. 

Select the business unit and optional selections on the Consignment Stock Items 
selection window. 

 

In the following example, the report includes consignment stock items with a status 
of Sold. 
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Report Description 

Item Barcode 
Labels 

Print out barcode labels for the selected stock items. These are stuck onto items 
when they are received so that when the operator is selling them, they can scan the 
barcode which speeds up the sales process. 

Use the selections to print the required label. For example, if you receive ten new 
shirts with the same item code: 

 select the Item Code from the drop-down list 

 type 10 in the Number of Labels field. 

 

In the following example, the report includes all stock items, with 1 label printed for 
each item. 

 

Note: The report format of the sample has been adjusted to fit. 

The report prints onto labels that conform to the Avery L7158 standard. 

 

The 3 of 9 Barcode true type font needs to be installed onto your PC before you 
can print this report. 
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Report Description 

Item Sales Report on sales by business unit and item 

Select the business unit and optional selections on the Item Sales selection 
window. 

 

In the following example, the report includes all sales for the year. 
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Report Description 

Stock Re-
Order Form 

Report on items by business unit, where their stock on hand has fallen below the 
Re-order Stock Level set in Item Maintenance. See Item Maintenance - Stock tab 
(on page 19). 

Select the business unit and optional selections on the Stock Re-Order Form 
selection window. 

 

In the following example, the report is output using the standard selections. 
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Report Description 

Item Stock Report the amount of stock on hand for items that are sold by the selected business 
unit. Also see Item Stock Levels as at Date below. 

Select the business unit and optional selections on the Item Stock selection 
window. 

 

In the following example, the report is output using the standard selections. 
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Report Description 

Item Stock 
Levels as at 
Date 

Report the stock levels at a given date for items that are sold by the selected 
business unit. 

Select the business unit and date on the Item Stock Levels as at Date selection 
window, along with any optional selections. You can group by item category. 

 

In the following example, the report is output using the standard selections for 
today's date. 

 



Key sales reports Sales 

Version 65.19 Page 17-231 

Report Description 

Stock Price 
Listing 

Report the cost details, sale price and gross margin for items that are sold by the 
selected business unit. 

Select the business unit and optional selections on the Stock Price Listing 
selection window. 

 

In the following example, the report is output using the standard selections. 
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Report Description 

Sales Audit 
Trail - By 
Special Item 
Lookup 

Report sale details and summaries for the selected business unit to allow the sales 
to be audited. 

Select the business unit and optional selections on the Sales Audit Trail - By 
Special Item Lookup selection window. 

 

In the following example, the report is output using the standard selections of the 
default business unit and today's sales. 
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Report Description 

Sales Report Report sale details and summaries by general ledger code and date, for the 
selected business unit. 

Select the business unit and optional selections on the Sales Report selection 
window. 

 

In the following example, the report is output using the standard selections of the 
default business unit and today's sales. 
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Report Description 

Sales 
Summary 

Report on the overall sales by payment method for the selected business unit. 

Select the business unit and optional selections on the Sales Summary selection 
window. 

 

In the following example, the report is output using the standard selections of the 
default business unit and today's sales. 
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Report Description 

Department 
Sales 
Summary 

Summarise general ledger ("own use") sales by department and period. 

Select the business unit, report details and period, along with any optional 
selections on the Department Sales Summary selection window. 

 

In the following example, the report is output using the standard selections of the 
default business unit and today's sales. 

 

Refer to the example in Processing a general ledger or "own use" sale (on page 91) 
for details of how to perform a general ledger sale. 
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